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New TimeCoder Pro 

Online Administrator 

The entire online Account Manager has been rebuilt for 

TimeCoder Pro 6. The new TimeCoder Pro Administrator is 

designed to provide intelligent business and technical 

information about your TimeCoder Pro account. You can 

view activity in easy-to-use credit/debit columns (similar to 

an online banking website), filter synchronization data, 

download activity history, and print intelligent 

reports. Customize the Account Activity area to show just 

the fields you want to analyze, including new fields such as 

Matter Number, Case Name, Reporting Form, Job ID, Client 

ID, and Office. Remotely monitor the progress of several 

simultaneous synchronization jobs running from different 

TimeCoder Pro workstations from a browser, and much 

more! More Information 

MPEG-4 (H.264) 

Support 

TimeCoder Pro 6 now supports high definition MPEG-4 

(H.264) for synchronization and export to Classic DepoView 

volumes. As always, TimeCoder Pro leads the legal video 

industry in support of the latest video standards. Support 

for this video format allows videographers to offer 

synchronized Digital Video Transcripts using MPEG-4 

(H.264) files to their clients. Additionally, other inData 

products such as TrialDirector 6 and DepoView 6 will 

support playback, clip creation, and clip export for Digital 

Video Transcripts using MPEG-4 (H.264) video. When adding 

your video files to TimeCoder Pro, just select the .MP4 or 

.MOV file extension from within the Multimedia Manager.  

Larger Multimedia 

Window 

Postage-stamp sized video is a thing of the past. TimeCoder 

Pro 6 has a larger video window that is more compatible 

with modern video resolutions. The larger size enables you 

to easily see information within the deposition video, such 

as the date and time stamp. 
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Extended Deponent 

Information Fields 

Track more information when you create Digital Video 

Transcripts (DVTs), including Case Name, Matter Number, 

Client ID, Job Number, Office, and Reporting Firm. Any 

information entered into these fields is automatically posted 

to your online TimeCoder Pro Administrator for easy 

reporting and analysis. Additionally, each of these fields 

(such as Case Name) will store previously entered 

information in the dropdown list so you can simply select it 

the next time another DVT is created for the same case. You 

can also add this information after DVT creation in the Digital 

Video Transcript Properties. 

Required Deposition 

Information Fields 

You will now be prompted if all of the required fields are not 

filled out when creating a new Digital Video Transcript. This 

change ensures proper information is included with your 

synchronized transcripts. 

Click to View Original 

Transcript Link 

When you are completing the Create a New Digital Video 

Transcript wizard, most screens now include a link to the 

original transcript. This enables you to reference the 

transcript when filling out extended fields and other 

information. 
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MPEG-2 and DVD-

Video (VOB) Support 

Your videos have never looked better…TimeCoder® Pro now 

supports the higher resolution MPEG-2 and VOB file formats. 

It comes with a codec for syncing these files right out of the 

box. 

Encoding and 

Syncing from DV 

Save time and money when you record video depositions 

directly to AVI/DV. Now you can encode and sync files 

without any extra pre-treatment steps, eliminating hours of 

time from your workflow! Export your synced work product 

to DVD. In essence, TimeCoder Pro acts as your encoder, 

eliminating the need to purchase additional, expensive 

encoder hardware.  

More Information 

DVD Authoring and 

Burning 

TimeCoder Pro v5.2 now allows you to author and burn 

DVDs from within the program directly to inData’s new 

DepoView® DVD.  DepoView DVD is a hybrid DVD/software 

tool for viewing video depositions (patent-pending).  

More Information 

Mac Support 

Good news for all of the Mac® lovers out there: TimeCoder 

Pro v5.2 has been tested and verified to work on Apple® 

computers running the Microsoft Windows operating system 

in the Boot Camp®, ParallelsTM, and VMware Fusion 

environments. 

Additional Audio 

Processing 

Now you can enable additional audio processing for 

RapidSync®to reduce the time you spend afterward 

performing quality control. You'll notice a significant 

decrease in the number of questionable (i.e. yellow) lines in 

your transcript. More Information 

Short Answer 

Accuracy 

TimeCoder Pro v5.2 has been enhanced to synchronize short 

answers in a deposition (e.g. Yes, No) with greater accuracy 

than ever before. 

Free Tutorials 

Learn TimeCoder Pro software in just 18 minutes with our 

new comprehensive tutorials. You can open the “Getting 

Started” list of tutorials at any time from the Help menu. 

Each tutorial is only 2-6 minutes in length, allowing you to 

learn topics of importance to you at a time convenient to 

you. Additional tutorials are also available at 

http://www.indatacorp.com. 

http://www.indatacorp.com/
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TimeCoder Pro 

Marketing Program 

Are you looking for better ways to market your video 

services?  inData now offers customizable brochures and 

mailers exclusively to TimeCoder Pro clients. Add your logo, 

contact information, special promotions, information about 

your company, and more to customizable, professionally 

designed templates.  The only cost to you is the cost of 

materials and postage, paid directly to a third-party 

printer/mailhouse. Details may be found in the TimeCoder 

Pro Online Account Manager under Support. 
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Updated Graphics 

and User Interface 

TimeCoder Pro gets a facelift with new graphics, features, 

and interfaces. New notifications and news feeds keep you 

up-to-date. 

New Online Account 

Manager 

The Account Manager – where you check job status and get 

additional sync credits – has been refined and enhanced. 

The Account Manager features a new interface and graphics, 

with new features like the ability to review billing 

individually for each sync project, and more detailed 

notification when a sync project is ready.  You’ll also get 

timely inData news announcements. 

Product Notifications 

Two new features keep you current with TimeCoder Pro. An 

“Updates Now Available” dialog will appear at start up to let 

you know when product updates can be downloaded. 

Additionally, a Product Bulletin will alert you to TimeCoder 

Pro news, such as when scheduled server maintenance 

could impact your TimeCoder processing.   

VistaTM Compatible 
TimeCoder Pro has verified compatibility with the new 

Microsoft Windows Vista™ operating system. 

Enhanced 64-bit 

Support 

TimeCoder Pro has support for Windows XP™ Pro x64 and 

Windows Vista™ 64-bit operating system versions. 

Enhanced Hardware 

Support 

TimeCoder Pro adds support for Intel® Core™2 Duo (64-bit) 

Processors which will increase RapidSync speeds by 40% 

over a standard 32-bit Pentium 4 CPU. 

TimeCoder Pro adds support for Intel® Core™2 Quad (64-

bit) Processors which will increase RapidSync speeds by 

90% over a standard 32-bit Pentium 4 CPU. 

Updated DepoView 

DepoView, the embedded video player, has a completely 

new, updated interface. The new DepoView is more 

compatible with other trial management tools, including the 

ability to export true CT Summation .sbf files. The 

condensed transcript printing function has been re-ordered 

to provide more logical rendering. 

Enhanced CT 

Summation Support 

TimeCoder now produces true CT Summation .sbf files. 

 Exports to CT Summation .sbf format now include exhibit 

hyperlinks and also the exhibits themselves in the .sbf.   
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Simplified, One-Step 

Product Registration 

Even TimeCoder Pro registration has become simpler. 

 Simply enter your product serial number and contact 

information in the registration wizard, and activation is 

automatic. 

Easy Conversion of 

Evaluation Software 

inData makes it easy to try TimeCoder Pro before you buy it 

– just download an evaluation copy.  If you like the product, 

you can easily convert to a full working version from the 

Help menu within the program. 

Improved Help File 

TimeCoder Pro’s Help file has been improved too. Help 

content has been updated, and you can now save your 

favorite Help topics for quick reference. 
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 Notes:  

   TimeCoder Pro has been developed and designed to work with a wide range of 

deposition formats; not every possible format may be properly imported by the 

transcript parser engine. 

   The list of supported and non-supported file types may change in future releases. 

  

The following deposition file types are supported by TimeCoder Pro: 

 AMICUS Format (*.ami, *.trn) 

 ASCII Format (*.txt, *.v1); must meet specific format requirements 

 LexisNexis TextMap Evidence File (*.xmef) 

 LiveNote/VideoNote Files (*.ptf/*.vid) 

 RealLegal E*Transcript Files (*.ptx) 

 Sanction II Transcript Database (*.mdb) 

 Timaro/TrialPro Post-Production Time Stamp file (*.pts) 

The following deposition file types are NOT supported by TimeCoder Pro: 

 Microsoft Word Documents (*.doc, *.docx) 

 Rich Text Format (*.rtf) 

 Adobe PDF (*.pdf) 

 TIFF Images (*.tif, *.tiff) 

  

When using ASCII format transcripts with TimeCoder Pro, they must meet the 

following requirements: 

 Must include integer-based page numbers (EXAMPLES: Page 1, 1, 0001, etc.) on 

the left or right-hand portion of the transcript. 

 Must include integer line numbers for all pages of the deposition. Line numbers are 

also required for title, certificate, appearances, exhibit list, and certificate pages. 

 No special characters (i.e. non-standard ASCII characters such as ö, ñ, é, etc.) 

 Court Reporter timestamps (i.e. relative or time of day timestamps) are allowed. 

However, they must be in one of the following formats: 

H:M:SS or HH:MM:SS 

Additionally, there must be at least one whitespace character between the 
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timestamps and the page number.   

EXAMPLE:  12:15:26 06 Q.    Please state your name. 

 Court Reporter information (EXAMPLE: ACME Court Reporters (800) 555-1212) 

should not be present at the header or footer of each page (i.e. Line 1 or 25). If this 

information is present, it can make clip creation more difficult and synchronized 

playback confusing to a judge or jury. 

 Question and Answer (Q/A) Pairs are required for all spoken portions of the 

transcript. 

 One (or more) whitespace characters must occur between each line number and 

text.    

EXAMPLE:  25         Q.     What was your involvement? 
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TimeCoderTM Pro allows you to create Digital Video Transcripts (DVTs) for use with 

TrialDirector and other applications supporting synchronized transcripts and video. In 

addition, a royalty-free, re-distributable DepoView application is included with TimeCoder 

Pro. DepoView is an easy way for parties without deposition management software to view 

and work with synchronized digital video.   

Because of its ability to export to multiple formats, TimeCoder Pro is the best solution for 

synchronizing transcripts and video. Some of TimeCoder Pro's features include: 

  

Multiple Syncing Options 

 RapidSync® - Synchronizes your transcript and video on average 20 times faster than 

realtime! The RapidSync engine uses the latest in audio mining, speech recognition, 

language modeling, and transcript format detection technologies to take the labor 

out of a once tedious task. 

 Send to inData - Too busy or have a large job requiring quick turnaround? Upload 

your materials to inData and our experienced technicians will quickly synchronize 

and Q/C your transcript for you with a 100% satisfaction guarantee! In just a short 

time, your deposition will be delivered to you ready to be branded with your 

company information and distributed to your clients. 

 AutoSyncTM - Synchronizes your transcript and video on average 2-3 times faster than 

real-time. 

 Manual Synchronization - Manually timestamp your deposition transcript to an 

associated deposition video. 

DepoView® DVD 

Give your clients the ability to review their video transcripts on a standard DVD player or 

personal computer with DepoView DVD. One DepoView DVD disc can store an entire full 

day’s deposition. Plus, DepoView DVD supports your choice of MPEG-1 or MPEG-2/VOB files. 

It even includes an MPEG-2 codec, so you can rest assured your clients will have a good 

user-experience playing the video on a PC. You can even brand the DepoView DVD main 

menu with your company logo and contact information. Each DepoView DVD includes a 

complimentary license of DepoView software for video clip creation that a user can 

download at their convenience. 
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Exhibit Linking 

Add electronic exhibits to your Digital Video Transcript and TimeCoder Pro will automatically 

find references to the exhibit within the transcript and create links. When your clients view 

the transcript in DepoView, they can easily review the linked exhibits by clicking on the 

icons that appear wherever an exhibit is mentioned. 

  

Encoding, Syncing, Authoring, and Burning to DVD 

Encode and sync files from AVI/DV without any extra pre-treatment steps, and export your 

synced work product to DepoView DVD. In essence, TimeCoder Pro acts as your encoder, 

eliminating the need to purchase additional, expensive encoder hardware. 

  

Online Account Management 

Monitor the status of your syncing projects at any time with TimeCoder Pro Administrator. 

View the amount billed for specific syncing projects, review accuracy and time statistics, 

conveniently access support, fund your account when needed, and more. 

  

Unlimited TimeCoder Pro Installations 

Install on as many systems as you require (per site location). 

  

Intuitive User Interface 

Because TimeCoder Pro uses a comprehensive set of keyboard commands, common tasks 

are made simple, and users can become familiar with the use of the product in a short 

period of time. 

  

Free Tutorials 

Learn TimeCoder Pro software in just minutes with our comprehensive series of tutorials 

available at http://www.indatacorp.com. 

  
  

http://www.indatacorp.com/


TimeCoder Pro User Manual 
 

11 

The system requirements for TimeCoder Pro are listed below. If you plan to create 

DepoView DVDs, ensure your system meets the Recommended Requirements. 

  

TimeCoder Pro Minimum Requirements (excluding DepoView DVD 

requirements): 
 

2.4Ghz Pentium™ 4 Processor 

 

Windows™ XP (SP2), or a Mac® running Windows in a Boot Camp®, ParallelsTM, or VMware 

FusionTM environment 

 

1 GB RAM 

 

Active Internet Connection (Cable, LAN, T1, etc.) 

 

Microsoft .NET Frameworks 4.0 

 

Microsoft Internet Explorer 7.0 or higher 

 

XGA Monitor (1024 x 768) at 16 million colors (High Color or True Color) 

 

4 GB Available Hard Disk Space 

 

DVD-R Drive (TimeCoder Pro is distributed on DVD) 

 

Sound Card and Speakers/Headphones (Required for video functions) 

   

TimeCoder Pro Recommended Requirements*: 
 

2.0Ghz or higher Intel® Core™ i3, i5, i7 or Intel® Core™2 Quad Processor 

 

Windows™ 7 (32-bit and 64-bit versions are both supported);  

or a Mac® running Windows in a Boot Camp®, ParallelsTM, or VMware FusionTM environment 

 

4 GB RAM 

 

Active Internet Connection (Cable, LAN, T1 etc.) 

 

Microsoft .NET Frameworks 4.0 

 

Microsoft Internet Explorer 9 

 

SXGA Monitor (1280 x 1024) at 16 million colors (High Color or True Color) 
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6 GB Available Hard Disk Space (15 GB if burning DepoView DVDs) 

 

DVD-RW Drive (for burning CDs or DepoView DVDs) 

 

Sound Card and Speakers/Headphones (Required for video functions) 

 

*RapidSync speeds of up to 60x real-time are capable when using Recommended 

Requirements  
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The following lists detail the multimedia file types supported for use with TimeCoder Pro. 

Note that the file types supported for export to DepoView DVD are listed separately below. 

 Audio files (*.aif, *.aiff, *.au, *.wav) 

 Audio Video Interleave files (*.avi) 

 Microsoft DV AVI files (*.avi) 

 MP3 files (*.mp3) 

 MPEG Audio files (*.mpa, *.mp2, *.m2a) 

 MPEG-1 files (*.mpg, *.mpeg) 

 MPEG-2 files (*.mpg, *.mpeg) 

 High Definition MPEG-4 H.264 (*.mp4, *.mov) 

 Windows Media files (*.asf, *.wmv, *.wma) 

 Video CD (*.dat) 

 DVD-Video (*.vob) - See Note 

 Microsoft DV AVI files (*.avi) 

 DVD-Video (*.vob) - See Note 

 MPEG-2 files (*.mpg, *.mpeg) 

 MPEG-1 files that meet the following specifications: 

o MPEG-1 Program Stream (Constant Bitrate) 

o Minimum Video Bitrate: 1150 Kbps 

o Maximum Video Bitrate: 1856 Kbps 

o Audio Bitrate: 224 Kbps 

o Audio Stream Type: MPEG-1 Audio Layer 2 

o Audio Frequency: 48,000 Hz 

o Resolution: 352 x 240 
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Note: If you load DVD-Video (.vob) in the Multimedia Manager, the inData 

DVD Extractor will automatically open to convert the DVD-Video to an MPEG-2 

program stream. This is necessary to export to DepoView DVD format. 
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The process for activation an evaluation copy is a little different.  Click here for the details. 

The standard installation of TimeCoder Pro anticipates an Internet connection for 

registration and activation. If you do not have an Internet connection, there are two options 

for obtaining the activation code: 

 If you have Internet access on another computer, you can get the activation code 

from the inData Web site. 

1. Install the software. After entering your serial number and registration code, 

you will be prompted for the activation code. (With an Internet connection, 

the activation code would be automatically received and accepted.) 

2. On the computer with Internet access, go to the www.indatacorp.com > 

Support > Product Registration and enter your serial number and 

registration code. Click Submit. 

3. An activation code will be displayed. Return to the computer without Internet 

access and enter the activation code exactly as shown. 

 

Your software will now function normally. 

 If you do not have another computer with Internet access, call Technical Support at 

480-497-0066 to obtain the activation code. 

 

Note: TimeCoder Pro will need an Internet connection in order to Automatically 

Synchronize Digital Video Transcripts. 

  

TimeCoder Pro can be installed on multiple computers within the same office location. 

Additional TimeCoder Pro licenses are required for computers outside of your primary 

location (i.e. branch offices). If you are installing TimeCoder Pro and get a message that 

you have exceeded your eligible activations, contact Technical Support at 480-497-0066, or 

http://www.indatacorp.com/
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on the Web at www.indatacorp.com. If you need to purchase additional copies of TimeCoder 

Pro, click here for more information. 

1. When the initial Registration screen appears, click Next to continue. 

2. Enter the TimeCoder Pro serial number. Click Next. 

3. Enter your contact information. Click Next. 

4. Review and confirm your contact information. Click the Back button to edit the 

displayed information, or Next to accept the information and finish the registration. 

When registration is complete, the activation code is automatically sent to your PC, 

completing the registration process. 

   

http://www.indatacorp.com/
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inData Corporation 

225 E Germann Rd., Suite 310 

Gilbert, AZ 85297 USA 

Phone: 480-497-8595 

Toll Free: 877-463-2829 

Fax: 480-497-1833 

Technical Support is available with every inData software product, 24 hours a day, 7 days a 

week on the inData Web site at www.indatacorp.com. Visit the Tips & FAQs page for helpful 

information about all inData products. 

 

Phone 

Phoenix Area 480-497-0066* 

Toll Free 866-419-4298* 

  

Fax 

480-497-1833** 

 

Email 

support@indatacorp.com** 

  

Standard Technical Support: This service provides telephone, fax, or email support to 

clients Monday through Friday, 9 am - 8 pm Eastern Standard Time, excluding holidays. 

*Current maintenance contract required. 

**Estimated Response Time (ERT) is 4 business hours for customers with a current 

maintenance contract, and 1 day for customers without a current maintenance contract. 

  
  

http://www.indatacorp.com/
mailto:support@indatacorp.com
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Are you using an evaluation copy of TimeCoder Pro? You can convert your evaluation copy 

to the fully licensed version at any time. Any projects that you created with the evaluation 

copy will be preserved, and you'll be able to continue working with them with the full 

version. 

You can activate your full version of TimeCoder directly from the Help menu. 

1. Click the Help menu and select Buy TimeCoder Pro Online. 

2. A shopping cart dialog will open, with several screens requesting registration and 

billing information. Complete the requested information, then click Checkout. 

 

3. When your information has been validated, your activation code will be automatically 

installed and your copy will be fully activated. 

4. If you have any questions, just call our sales staff at 800-828-8292. 

You can also obtain your activation code by ordering TimeCoder over the phone or through 

your purchasing department. Please contact us at 800-828-8292, or on the Web at 

www.indatacorp.com. 

   

http://www.indatacorp.com/
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Can't get enough of TimeCoder Pro? It's a common problem, and we have several solutions: 

Are you using an evaluation copy of TimeCoder Pro? Click here for online purchase 

instructions. 

Maybe you already have a copy of TimeCoder Pro and want to purchase additional copies. 

We have you covered! 

 You can order additional copies on the Web at www.indatacorp.com. 

 Would you rather talk to someone? Our friendly sales staff would be pleased to speak 

with you at 800-828-8292. 

 Do you need a lot of copies? For even greater savings, talk to the sales staff about 

our site license options! 

If you like TimeCoder Pro, you should consider our other litigation products and services. 

Our software products include: 

 TrialDirector® - Trial Presentation Software 

 TimelineXpress - Timeline Charting Software 

 DepoView™ - Video Review Software 

We also offer services including Data Analysis & Production, Trial Consulting & Preparation, 

and Encoding & Synchronization. 
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TimeCoder™ Pro features comprehensive tutorials to help you learn the program. To view the 

tutorials and the TimeCoder Pro Quick Start Guide, go to http://www.indatacorp.com. 

  

Review these topics for addditional information: 

 Introducing TimeCoder Pro 

 System Requirements 

 Supported Multimedia File Types 

 Launching TimeCoder Pro 

 Setting TimeCoder Options 

 Keyboard Commands 

  

http://www.indatacorp.com/
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Topics: 

 Launching TimeCoder Pro 

 The Application Window 

To open TimeCoder Pro, Select Start > All Programs > TimeCoder Pro 6 > TimeCoder 

Pro 6. 

Note: If your software was not unlocked and registered, a preliminary window will 

appear, prompting you to activate the software. 

The TimeCoder Pro splash screen appears, followed by the "Open a Digital Video Transcript" 

dialog, as shown below. 

 

Select the DVT you wish to work with from the list.  Click Open to display the DVT in the 

main application window.  

The TimeCoder application window consists of the Menu Bar, Tool Bar, Keyboard Commands 

List, Transcript Window, Video Monitor, Multimedia Selection Box and Multimedia Control 

Box, as shown below. 
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Click the links below to view a detailed description of each TimeCoder Pro application 

window component: 

 Menu Bar 

 Tool Bar 

 Keyboard Commands List 

 Transcript Window 

 Video Monitor 

 Multimedia Speed Slider Control 

 Multimedia Control Box 

 Multimedia Selection Box 

Menu Bar - The Menu Bar provides the following menus to use while in TimeCoder: File, 

Edit, View, Multimedia, Tools and Help. 

 

Tool Bar - The Tool Bar provides quick access to many of the options found within the 

various program menus.  Also, the TimeCoder Pro tool bar contains options specific to QC 

Mode.  Below is a brief description of each tool bar option. 
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Note:  The "Move to Next Suspect Line", "Move to Previous Suspect Line", and "QC 

Accuracy Threshold Slider" options are only available when QC Mode is enabled.  For more 

information about using QC Mode, click here. 

  

Keyboard Commands List - The Keyboards Commands List shows all of the hot keys that 

can be used in TimeCoder Pro. 

 

Transcript Window - The Transcript Window displays the currently opened transcript 

text.  Timecodes are inserted on the left side of the transcript.  Page numbers appear to the 

right of timecodes in a 5-digit format. (ex. 00004)  The line numbers appear after the page 

number and a separator character (colon).  

 

Video Monitor - The Video Monitor displays the currently opened video file. 
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Multimedia Slider Control - The scroll bar on the right side of the Video Monitor allows 

you to increase the speed of the multimedia playback up to twice the normal speed. 

  

Multimedia Control Box - The Multimedia Control Box allows you to enter and exit 

Timecoding Mode (Timecoding Mode allows you to timestamp the transcript) and to play, 

pause, stop, rewind, fast forward, seek, and adjust the volume on multimedia files.  

 

Multimedia Selection Box - The Multimedia Selection Box lists all of the currently 

available multimedia files.  If multiple multimedia files are available, a small arrow will 

appear on the right side of the box, which will allow you to cycle through the list. 
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The following keyboard commands are available during the timecoding process: 

Home Jump to the beginning of the transcript. 

End Jump to the end of the transcript. 

Page Up Jumps back one full page of displayed transcript.  

In this case, a page is a section of the transcript that 

can be displayed in the Transcript Window at one time. 

Page Down Jump forward one full page of displayed transcript.  

In this case, a page is a section of the transcript that 

can be displayed in the Transcript Window at one time. 

Up Arrow Move to the previous line of the transcript. 

Down Arrow Move to the next line of the transcript.  

Use this key to move forward in the transcript without 

stamping lines that do not need timecodes (e.g., 

appearances, recesses, etc.) 

Left Arrow 
Rewind the multimedia file by the number of seconds 
designated in the TimeCoder options. 

Right Arrow Advance the multimedia file by the number of seconds 
designated in the TimeCoder options. 

Add (+)  
Increase the multimedia file playback speed up to two 

times the normal speed. 

Subtract (-) Decrease playback speed back to normal speed. 

Spacebar Stamp the current time displayed in the Multimedia 
Control Box to the left side of the currently selected 
transcript line. 

Delete Remove the timecode from the currently selected 
transcript line. 

Pause Toggles Play or Pause mode for the multimedia file. 

N 

Moves to the next suspect line when running QC on an 
automatically synchronized transcript.  This key will 

locate any timestamped lines with a confidence score 
between 1 and 99. 

B 

Moves to the previous suspect line when running QC 
on an automatically synchronized transcript.  This key 
will locate any timestamped lines with a confidence 

score between 1 and 99. 

ALT + N 
Moves to the next missing or out of sequence 
timestamp.  Use they keystroke when running QC on 
an automatically synchronized transcript.  
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ALT + B 
Moves to the previous missing or out of sequence 
timestamp.  Use they keystroke when running QC on 
an automatically synchronized transcript.  

X 

Used to toggle between spoken (red) and unspoken 
(grey) text in QC mode.  To help improve AutoSync & 
RapidSync accuracy and speed results, you may want 
to check the spoken/unspoken lines at the beginning 
and end of the transcript prior to processing.  Although 
this step is not required, it can help on certain 
transcripts.  

<Enter> 
Seeks multimedia position to the timestamp 
associated with the current transcript line. 
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After your DVT data path has been established, it is time to create a new Digital Video 

Transcript. During the DVT creation process, the deposition transcript is processed into the 

DVT database. Optionally, you may process the associated Audio/Video reference files along 

with a pre-timecoded transcript. 

  

To create a new DVT 

1. On the File menu, click Create a New Digital Video Transcript to open the 

wizard. 
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2. Click Browse to select the deposition transcript you want to use. Click Next to 

continue. The following screen will appear: 

 

 

3. Enter the deponent information as shown in the screen above. If needed, use the 

Other field to include additional case or deposition information. Click the link if you 

want to view the actual transcript text file. Click Next to continue. The screen below 

will appear:  
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4. Confirm the page and line information for the transcript text file. Click the link if you 

want to view the actual transcript text file. Click Next to continue. The following 

screen will appear: 

 

 

5. You have the option to preserve the original timecodes within a deposition transcript, 

if they exist. Click here to view the steps involved to preserve timecodes. If you want 

to import the transcript without timecodes, click Next to continue. The following 

screen will appear: 
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6. To track additional information, enter or select the appropriate item for each field as 

shown above. Then, click Next. 

7. Click Create to begin the DVT creation process. 

 

 

  

8. After the DVT has been created, the screen below is displayed so you can review the 

creation results. 

 

 

9. Click OK to open the newly created DVT, or click Again to create another DVT. 
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After one or more Digital Video Transcripts have been created, they can be opened to 

timecode, QC, export or review. 

1. To open an existing Digital Video Transcript, select Open a Digital Video 

Transcript from the File menu. 

 

2. Select the DVT you want to work with and click Open. The transcript will be loaded 

into TimeCoder Pro. 

Note: The Digital Video Transcripts listed are those located within the data path 

established within the TimeCoder Pro Options. If you do not see the DVT's you want to work 

with, select OPTIONS from the View menu to verify that the DVT data path is correct. 
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Digital Video Transcript information that was established when the DVT was created can be 

edited. This information is tracked in TimeCoder Pro Administrator when the DVT is 

sychronized, which can be helpful for billing or other reporting purposes. 

1. From the View menu, click Digital Video Transcript Properties.... When the 

Digital Video Transcript Properties dialog box appears, the existing deponent 

information is displayed. 
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Below is a list of fields that can be edited: 

General 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name Deponent’s last name 

Suffix 
Suffix appended to deponent’s name. Examples: Jr., 

Sr., Esq. 

Date 
Deposition date.  Click on the arrow next to the Date 

field to select the date from a calendar. 

Volume #  Deposition volume number 

Other 
Additional information, such as court reporter or 

videographer. 

Case Name Name of the case the deposition applies to. 

Matter Number Matter number associated with the deposition. 
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Extended 

Client ID 
The number or name your company uses for the 

client. 

Job Number A tracking number your company uses for this DVT. 

Office The office location responsible for this DVT. 

Reporting Firm 
Court reporting firm that provided the transcript of the 

deposition. 

2. Edit the fields you want to change and click Apply to update the information. 

3. Click Exit close the window. 
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Topics: 

 Changing the Digital Video Transcript Data Path 

 Creating a New Digital Video Transcript 

 Preserving Existing Timecodes 

 Adding and Organizing Multimedia Resources 

 Removing Multimedia Resources 

 Replacing Multimedia Resources 

 Opening an Existing Digital Video Transcript 

 Removing a Digital Video Transcript 

 Editing Digital Video Transcript Information 

 Digital Video Transcript Status 

 Linking Exhibits to a Digital Video Transcript 

 Closing a Digital Video Transcript 
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Use the status of your Digital Video Transcripts to keep them organized. The status icons 

that are displayed next to the Digital Video Transcript in various windows throughout 

TimeCoder Pro allow you to quickly discern which DVT's need to be synchronized, which 

DVT's need to be QC checked, and which are ready for export. 

 

The following statuses are available: 

Imported But 

Not Synchronized 

This is the initial status of the Digital Video Transcript when it 

is created or imported. These Digital Video Transcripts still 

need to be synchronized. 

Synchronized 

But Needs QC 

This status is for Digital Video Transcripts that have been 

synchronized, either using AutoSync, RapidSync, or manual 

timecoding. These Digital Video Transcripts still need to be 

QC checked. 

Finished and 

Ready for Export 

This status is for Digital Video Transcripts that have been 

synchronized and QC checked. These Digital Video Transcripts 

are ready to be exported. 
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To change the status of a Digital Video Transcript, select the new status from the Status 

menu. 
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To close a DVT, select Close Digital Video Transcript from the File menu. 
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Topics:  

 Important Information About Transcript Timecodes 

 Preserving Transcript Timecodes 

During the Digital Video Transcript (DVT) creation process, users are given the option to 

preserve timecodes. This option is designed to preserve existing timecodes within the 

deposition transcript used during the DVT creation process. Timecodes are usually 

generated in a transcript by the court reporter using "real-time" steno software. 

Below are some requirements of a transcript when preserving timecodes: 

 Timecodes must exist on the left margin. 

 Timecodes must be in SMPTE format (HH:MM:SS). An example of this format is 

01:23:10. 

 Timecodes must not exceed 24 hours in duration. 

Note: Timecodes may be in a linear format or time of day format, as long as they 

adhere to the SMPTE format. 
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Preserving timecodes is a multi-step process. Follow the steps below to preserve timecodes. 

1. During the DVT creation process, the dialog below appears allowing one to preserve 

timecodes within the deposition transcript if desired. Check the "Preserve original 

printed timecodes" option, as shown below. 

 

2. Optionally, you can select the "Adjust first timecode to 00:00:00" option. This option 

will readjust timecodes to offset at 00:00:00 in order to list the timecodes in a linear 

fashion. If you wish to maintain timecodes in their original state (ex. time of day), 

you can clear this option. For best results, we recommend leaving this option 

selected. 



TimeCoder Pro User Manual 
 

43 

3. Next, the associated audio/video resource(s) for the Digital Video Transcript must be 

added in chronological order. This process will determine the running time(s) of the 

audio/video resource(s), then match those resources against the timecodes within 

the deposition transcript. Click Add to begin adding the audio/video resources. The 

following window will appear: 

 

4. Browse to the location of the first audio/resource file and select Open to add to the 

list. Repeat the process for any other additional audio/video reference files. When 

completed, the audio/video reference files will appear in the list as depicted below. 

 

5. Click Next to continue through the process. After the DVT has been created, the 

timecodes will appear within the deposition transcript. Also, the associated 

audio/video reference files are available to review. 

6. Check the synchronization of the DVT by playing back each of the associated 

audio/video references. Slide the seek bar (on the Multimedia Control Box) to various 

places within the reference file to make sure the playback is in synchronization with 

the timecoded transcript. You may have to adjust timecodes as necessary. After you 

have checked the DVT for proper synchronization, it can be exported. 
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Topics: 

 Importing a TrialDirector™ Case File (*.cms) 

 Importing LexisNexis® TextMap® Evidence Files (.xmef) 

 Importing LiveNote™ / VideoNote™ Files (*.ptf/*.vid) 

 Importing RealLegal™ E*Trancript™ Files (*.ptx) 

 Importing a Sanction II™ Transcript Database (*.mdb) 

 Importing Timaro™ Post-production Timestamps File (*.pts) 

 Importing TrialPro™ Post-production Timestamp File (*.pts) 

 Importing YesEdit™ CD-ROM with Sanction II Database File (*.mdb) 

 

The TimeCoder Pro import features are especially useful for converting one timestamp file 

format to another.  For example, a Sanction II™ transcript database (*.mdb) can be 

converted to a TrialDirector Case File (*.cms) via the TimeCoder Pro import/export 

features.  
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TimeCoder Pro can import existing *.cms files that may have been created in previous 

versions of TimeCoder, TrialDirector or DVTWizard. TimeCoder Pro users may want to 

import legacy *.cms files to correct timecodes, add/remove multimedia resource files, 

adjust timecodes etc. After the *.cms file is imported into TimeCoder Pro, it can even be 

exported to other formats. 

When a synchronized transcript is contained within a TrialDirector Case, we will need to 

import the corresponding *.cms file. 

To import from a TrialDirector Case 

1. Select Import from... | TrialDirector Case file (*.cms) from the File menu. 

 

2. Enter a destination folder and filename for the *.CMS file, or click Browse to 

navigate to the desired folder and filename.  

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and *.CMS file and click Open.  

3. When the desired folder and filename are selected, click Next. 

 

4. Select the Digital Video Transcript(s) you would like to import into the current case. 

Click Select All to import all Digital Video Transcripts or Clear All to clear all selections. 

5. Click Next to continue. 

 

6. Click Import to begin the import process. 
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7. Review the import results carefully to ensure that no errors were encountered. 

8. Click OK to complete the import process. 
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You can import LexisNexis® TextMap® Evidence files (.xmef) into TimeCoder Pro. 

 

To import an evidence file 

1. On the File menu, point to Import from..., then click  LexisNexis(R) TextMap(R) 

Evidence File (*.xmef). 

2. Enter a destination folder and filename for the *.xmef file, or click Browse to 

navigate to the desired folder and filename.  

 

 

  

3. When the desired folder and filename are selected, click Next. 

  

4. Verify the information for the deponent is correct and make changes as needed. 
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The Deposition Information or Other sections can be enabled or disabled by checking 

or removing the checkmark from their respective boxes; however, both cannot be 

disabled at the same time. If you choose to enable the Deposition Information, the 

First, Last, Date, and Volume # fields must be filled in. If you choose to enable 

Other, the text box must be filled in.  

5. When you are finished entering information into the fields, click Next. 

6. Verify the page and line information is correct. If the first page of the transcript that 

contains line numbers is a page other than 1, enter the correct page number or use 

the small arrow buttons to select the correct page number. Click Next to continue. 
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7. This screen will allow you to preserve timecodes that may appear in the original 

printed transcript. If you want to preserve timecodes, you must specify all 

audio/video resource(s) for this Digital Video Transcript in chronological order. Click 

here for instructions on preserving timecodes. Otherwise, click Next. 

 

 

  

8. To begin the import process, click Create. 

 



TimeCoder Pro User Manual 
 

51 

 

  

9. Review the import results carefully to ensure that no errors were encountered. Then, 

click OK. 

The transcript will appear in TimeCoder Pro. 
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When a synchronized transcript is imported from a LiveNote™ / VideoNote™ file, you will 

need to import the .ptf and .vid files that were created from the original application. 

To import files from LiveNote / VideoNote 

1. Select Import from... | LiveNote™/ VideoNote™ files (*.ptf) (*.vid) from the 

File menu. 

 

2. Enter a destination path and filename for the *.PTF file, or click Browse to navigate 

to the desired folder and filename. 

Note: If the *.PTF and *.VID files reside in the same directory, selecting the 

*.PTF will select the associated *.VID file, as well. 

a. If you click Browse the following window appears: 

 

b. Select the desired destination folder and *.PTF file and click Open. 
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3. When the desired folder and filename are selected, click Next. 

 

4. Enter the information for the deponent. 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name Deponent’s last name 

Suffix 
Suffix appended to deponent’s name. Examples: Jr., 

Sr., Esq. 

Date Deposition date 

Volume # Deposition volume number 

Other Additional information 

5. The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both cannot be 

disabled at the same time. If you choose to enable the Deposition Information, the FIRST, 

LAST, DATE and VOLUME # fields must be filled in. If you choose to enable the Other 

Information, the OTHER field must be filled in. 
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6. When you are finished entering information into the fields, click Next. 

 

7. If the first page of the transcript that contains line numbers is a page other than one, 

enter the correct page number or use the small arrow buttons to select the correct page 

number. 

8. Click Next to continue. 

 

9. If you would like to preserve VideoNote™ timecodes, you must specify all multimedia 

resources associated with the VideoNote (*.vid) file in chronological order. Click here for 

instructions on preserving timecodes. 

10. Click Next to continue. 
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11. Click Create to begin the import process. When the progress bar reaches the end, 

the import is complete. 

 

12. Review the import results carefully to ensure that no errors were encountered. 

13. Then select OK to complete the import process. 
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When a synchronized transcript is imported from a RealLegal™ E*Transcript™ file, you will 

need to import the .ptx file that was created in the original application. 

To import files from RealLegal 

1. Select Import from... | RealLegal™ E*Transcript™ (*.ptx) from the File menu. 

 

2. Enter a destination folder and filename for the *.PTX file, or click Browse to 

navigate to the desired folder and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and .PTX file and click Open. 

NOTE:  TimeCoder Pro can import either the .PTX or .EXE format of E*Transcript files.  

3. When the desired folder and filename are selected, click Next. 
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4. If the selected .PTX/.EXE file requires a password, the following dialog will be 

displayed. 

 
  

5. Enter the required password and click Next to continue.  The password is generated 

by the authoring entity of the E*Transcript file.  If the password cannot be obtained, 

the file cannot be imported.  You will have to contact the author of the E*Transcript 

file to obtain the password. 

 

6. Enter the information for the deponent. 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name  Deponent’s last name 

Suffix Suffix appended to deponent’s name. Examples: Jr., Sr., Esq. 
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Date Deposition date 

Volume # Deposition volume number 

Other  Additional information 

7. The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. If you choose to enable the Deposition 

Information, the FIRST, LAST, DATE and VOLUME # fields must be filled in. If you 

choose to enable the Other Information, the OTHER field must be filled in. 

8. When you are finished entering information into the fields, click Next. 

 

9. If the first page of the transcript that contains line numbers is a page other than one, 

enter the correct page number or use the small arrow buttons to select the correct 

page number. 

10. Click Next to continue. 
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11. This window indicates that you are ready to import the DVT. Click Create to begin 

the import process. 

 

12. Review the import results carefully to ensure that no errors were encountered. 

13. Select OK to complete the import process. 
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When a synchronized transcript database is created within the Sanction™ II application, the 
corresponding *.mdb file can be imported into TimeCoder Pro. 

To import from a Sanction II™ Transcript Database file 

1. Select Import From... | Sanction™ II Transcript Database (*.mdb) from the 

File menu. 

 

2. Enter a destination folder and filename for the *.MDB file, or click Browse to 

navigate to the desired folder and filename.   

a. If you click Browse, the following window appears: 

  

b. Select the desired destination folder and .MDB file and click Open. 
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3. When the desired folder and filename are selected, click Next.  

 

4. Enter the information for the deponent. 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name  Deponent’s last name 

Suffix 
Suffix appended to deponent’s name. Examples: Jr., 

Sr., Esq. 

Date Deposition date 

Volume # Deposition volume number 

Other  Additional information 

The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. If you choose to enable the Deposition 

Information, the FIRST, LAST, DATE and VOLUME # fields must be filled in. If you 

choose to enable the Other Information, the OTHER field must be filled in. 
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5. When you are finished entering information into the fields, click Next. 

 

6. If the first page of the transcript that contains line numbers is a page other than one, 

enter the correct page number or use the small arrow buttons to select the correct 

page number. 

7. Click Next to continue. 

 

This window will allow you to preserve timecodes which may appear in the original 

printed transcript. If you want to preserve timecodes, you must specify all 

audio/video resource(s) for this Digital Video Transcript in chronological order. Click 

here for instructions on preserving timecodes. 
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8. If you choose not to preserve original printed timecodes, select Next to continue. 

 

9. This window indicates that you are ready to import the DVT. Click Create to begin 

the import process. 

 

10. Review the import results carefully to ensure that no errors were encountered. 

11. Then select OK to complete the import process. 
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When a synchronized transcript is imported from a  Timaro™ Post-production Time Stamp 

file, you will need to import the .pts file that was created in the original application. 

To import files from Timaro 

1. Select Import from... | Timaro Post-production Time Stamp file (*.pts) from 

the File menu. 

 

2. Enter a destination folder and filename for the *.PTS file, or click Browse to 

navigate to the desired folder and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and .PTS file and click Open.  

3. When the desired folder and filename are selected, click Next. 
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4. Enter the information for the deponent. 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name  Deponent’s last name 

Suffix 
Suffix appended to deponent’s name. Examples: Jr., 
Sr., Esq. 

Date Deposition date 

Volume # Deposition volume number 

Other  Additional information 

5. The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. If you choose to enable the Deposition 

Information, the FIRST, LAST, DATE and VOLUME # fields must be filled in. If you 

choose to enable the Other Information, the OTHER field must be filled in.  

6. When you are finished entering information into the fields, click Next. 
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7. If the first page of the transcript that contains line numbers is a page other than one, 

enter the correct page number or use the small arrow buttons to select the correct 

page number. 

8. Click Next to continue. 

 

This window will allow you to preserve timecodes which may appear in the original 

printed transcript. If you want to preserve timecodes, you must specify all 

audio/video resource(s) for this Digital Video Transcript in chronological order. Click 

here for instructions on preserving timecodes. 

9. If you choose not to preserve original printed timecodes, select Next to continue. 
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10. This window indicates that you are ready to import the DVT. Click Create to begin 

the import process. 

 

11. Review the import results carefully to ensure that no errors were encountered. 

12. Then select OK to complete the import process. 
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When a synchronized transcript is imported from a TrialPro™ Post-production Time Stamp 

file, you will need to import the .pts file that was created in the original application. 

To import files from TrialPro 

1. Select Import from... | TrialPro Post-production Time Stamp file (*.pts) from 

the File menu. The following window appears: 

 

2. Enter a destination folder and filename for the *.PTS file, or click Browse to 

navigate to the desired folder and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and .PTS file and click Open.  

3. When the desired folder and filename are selected, click Next. 
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4. Enter the information for the deponent. 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name  Deponent’s last name 

Suffix 
Suffix appended to deponent’s name. Examples: Jr., 

Sr., Esq. 

Date Deposition date 

Volume # Deposition volume number 

Other  Additional information 

5. The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. If you choose to enable the Deposition 

Information, the FIRST, LAST, DATE and VOLUME # fields must be filled in. If you 

choose to enable the Other Information, the OTHER field must be filled in. 

6. When you are finished entering information into the fields, click Next. 
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7. If the first page of the transcript that contains line numbers is a page other than one, 

enter the correct page number or use the small arrow buttons to select the correct 

page number. 

8. Click Next to continue. 

 

This window will allow you to preserve timecodes, which may appear in the original 

printed transcript. If you want to preserve timecodes, you must specify all 

audio/video resource(s) for this Digital Video Transcript in chronological order. Click 

here for instructions on preserving timecodes. 

9. If you choose not to preserve original printed timecodes, select Next to continue. 
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10. This window indicates that you are ready to import the DVT. Click Create to begin 

the import process. 

 

11. Review the import results carefully to ensure that no errors were encountered. 

12. Then select OK to complete the import process. 
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When a synchronized transcript database is created on YesEdit™ CD-ROM with Sanction™ II 

Transcript Database application, the corresponding *.mdb file can be imported into 

TimeCoder Pro. 

To import from a YesEdit™ CD-ROM with Sanction™ II Transcript Database file 

1. Select Import from... | YesEdit™ CD-ROM with Sanction™ II Transcript 

Database (*.mdb) from the File menu. 

 

2. Enter a destination folder and filename for the *.MDB file, or click Browse to 

navigate to the desired folder and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and .MDB file and click Open.  

3. Once the desired folder and filename are selected, click Next. 
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4. Enter the information for the deponent. 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name  Deponent’s last name 

Suffix 
Suffix appended to deponent’s name. Examples: 

Jr., Sr., Esq. 

Date Deposition date 

Volume # Deposition volume number 

Other  Additional information 

   

The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. If you choose to enable the Deposition 

Information, the FIRST, LAST, DATE and VOLUME # fields must be filled in. If you 

choose to enable the Other Information, the OTHER field must be filled in. 

5. When you are finished entering information into the fields, click Next. 
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6. If the first page of the transcript that contains line numbers is a page other than one, 

enter the correct page number or use the small arrow buttons to select the correct 

page number. 

7. Click Next to continue.  

 

This window will allow you to preserve timecodes, which may appear in the original 

printed transcript. If you want to preserve timecodes, you must specify all 

audio/video resource(s) for this Digital Video Transcript in chronological order. Click 

here for instructions on preserving timecodes. 

8. If you choose not to preserve original printed timecodes, select Next to continue.  
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9. This window indicates that you are ready to import the DVT. Click Create to begin 
the import process.  

 

10. Review the import results carefully to ensure that no errors were encountered. 

11. Then select OK to complete the import process. 
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To preserve the existing VideoNote timestamps during import 

1. Check the Preserve VideoNote™ timecodes option. 

 

2. Click Add to specify one or more multimedia resource files that correspond with the 

original VideoNote (.VID) file. 

 

3. Select the multimedia file(s) and click Open to add the selection(s) to the list. 

4. Repeat the process until all multimedia resource files are added to the list. 
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5. If the multimedia resource files are not in chronological order, use the Up or Down 

buttons to adjust the position of the multimedia resources as necessary. 

6. When all of the multimedia resource files have been added, click Next to continue. 
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After you create a new Digital Video Transcript (DVT), you need to add one or more 

audio/video files using the Multimedia Manager. If you have multiple audio/video files that 

accompany a transcript, use the Multimedia Manager to organize the files before you 

synchronize (timecode) the transcript with them.  

To open the Multimedia Manager 

On the Multimedia menu, click Multimedia Manager. 
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1. Click Add Files to select one or more multimedia resource files to add to the DVT. 

2. Browse to the location of the multimedia file(s) and select. To select more than one 

file, press and hold CTRL. 

3. Click Open. 

4. The file(s) appear in the Multimedia Manager. If they are not in chronological order, 

use the Up and Down buttons to adjust the position of the multimedia resources as 

necessary. 

The files must be in order to ensure accuracy when the transcript is synchronized 

(timecoded) with the multimedia files. 

 

Note to TrialDirector Users: The path of each multimedia resource 

file is used in the *.cms file exported from TimeCoder Pro. Once the 

*.cms file is loaded into TrialDirector, the user may have to browse to 

the multimedia file location if the path is different. 

5. If you are finished adding and organizing multimedia files, click OK to return to the 

transcript. The first file listed in the Multimedia Manager will appear in the 

Multimedia Selection Box. 

Use the Add DVD button whenever you are loading files from a DVD or VCD, or when the 

contents of the DVD/VCD has been copied to a folder on a local or network drive. 

 

Note: Super Video CDs (SVCDs) are not supported. 

1. Click Add DVD. 

2. If the disc is currently mounted in a drive, browse to and select the drive letter. 

-or- 

If the disc contents has been copied on to a local or network drive, browse to and 

select the root folder of the DVD/VCD contents. 

3. Click OK. 

The inData Digital Video Disc (DVD) Extractor automatically opens. 

4. Use the inData Digital Video Disc (DVD) Extractor to convert the video to an MPEG-2 

stream. Then, select the .MPG file and click Open. 

5. Repeat the previous steps for any additional DVDs/VCDs. 
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If you will be exporting a synchronized transcript and multimedia files across multiple 

CDs/DVDs, you can use groups to designate which files should go on which discs. 

 

Note: DVD and VCD disks should remain in their original groupings in order to 

maintain continuity between the source disk and the output DepoView 

volumes. 

1. In the Multimedia Manager, click the New Group button. 

A folder named Untitled Multimedia Group appears. 

2. Click once on the folder name to select it. Then, click again to insert the cursor on 

the text. Type a meaningful name for the group (for example, the deponent's initials, 

deposition date, and the disc number: SK110907 Disc1). 

3. Repeat the previous steps to create groups for ..Disc2, ..Disc3, etc. as needed. 

4. Select a file and click the Up/Down buttons as needed to move it to the appropriate 

location under the appropriate group. Repeat for each file. Ensure all files are in 

chronological order on each disc. 

 

The following example shows the structure for a deposition expected to span three 

discs when it is exported: 
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5. When you are finished organizing files in groups, click OK. 

You can return to the Multimedia Manager at any time before you export the 

synchronized transcript and multimedia files to CDs/DVDs to reorganize or replace 

them as needed. 

   



TimeCoder Pro User Manual 
 

83 

The inData Digital Video Disc (DVD) Extractor converts DVD-Video to MPEG-2 program 

streams. Prior to synchronizing these files with a transcript and using the DepoView DVD 

Creator, all source video deposition footage on DVD must be converted. 

The Extractor automatically opens after you use the Multimedia Manager to add a DVD. You 

can also open it anytime from the Tools menu. 

Before you begin 

 Make sure plenty of disk space is available for the folder that will contain the MPEG-2 

file(s) extracted from the DVD. A 2-hour DVD can use as much as 4.7GB of disk 

space. 

 For the quickest processing, run the Extractor on an Intel Core2Duo PC and use a 

local hard disk as the output location. 

 

Caution: Do not use the inData Digital Video Disc (DVD) Extractor to convert 

copyright protected DVD-Video titles. 

  

To extract DVD-Video 

1. If necessary, click Browse next to the Source box and navigate to the DVD drive. If 

you already selected the DVD in Multimedia Manager, the drive letter will 

automatically appear. If the contents of the DVD was copied to a local or network 

drive, select the root folder where the DVD was copied (not the VIDEO_TS 

subfolder). 

2. If necessary, click Browse next to the Output folder box and navigate to the 

location where you want the MPEG-2 file(s) to be saved. 

The default location is your My Documents folder on the computer. 

3. If necessary, change the Base filename for extracted TitleSets. 

The default base filename is the first and last initial of the deponent followed by the 

deposition date derived from the active DVT open in TimeCoder Pro. 

4. Click Begin. 

The status bar at the bottom of the Extractor shows the percentage complete and 

the time remaining (Trem). You can minimize the Extractor and continue to work 

while the conversion is completed. 

 

If the DVD contains multiple titles, separate .MPG files are created for each with 

suffixes appended to the filenames (-01, -02, etc.). 

5. When the conversion process is complete, click Exit. 
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6. If you were loading the video in Multimedia Manager, the Browse for Multimedia 

file(s) dialog box appears. Select the new .MPG file(s) from the output folder 

specified in the Extractor. Then, click Open. 

The new .MPG file(s) appear in the Multimedia Manager, and are ready to be 

synchronized with the transcript. Once synchronization and quality control are 

complete, you can export the transcript and associated .MPG file(s) to DepoView 

DVD. 
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If a particular multimedia resource is no longer needed, it can be easily removed from the 

Digital Video Transcript. 

 

Caution: If you remove a multimedia file after a transcript has been 

synchronized (timecoded), all associated timecodes will be removed. 

  

To remove a multimedia resource file from the list 

1. On the Multimedia menu, click Multimedia Manager. 

2. Select the multimedia resource you want to remove. 

3. Click Remove. 

4. Click Yes to confirm the removal. 
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You may encounter situations when a multimedia file needs to be replaced. In cases where 

a multimedia file that was synchronized with a transcript needs to be replaced with a better 

quality file, TimeCoder Pro enables you to replace the file without losing existing timestamps 

created from the original file. 

 

Caution: If the duration of the replacement file and the original file are 

considerably different, timecodes will be removed when the file is replaced. 

  

To replace a multimedia file 

1. On the Multimedia menu, click Multimedia Manager. 

2. Select the multimedia resource file you want to replace. 

3. Click Replace. 

4. Browse to the location of the new file that will replace the original and click Open. 

5. Click Yes to replace the file. 

 

Note: It may be necessary to adjust timecodes for the replacement multimedia 

file if significant running time differences exist between the original and 

replacement files. 
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To verify that the multimedia resource files are sorted in chronological order, do one of the 

following: 

 Select the  tool button 

 Select Perform Quality Control (Q/C) Checks from the Edit menu. 

When the Quality Control (Q/C) Check is performed, the chronological order of the 

associated multimedia files is checked. When it appears that the media files are not in the 

correct order in relation to the timecoded transcript, a warning will be displayed. 

 

Use the Up/Down buttons in the Multimedia Manager to correct the order of the multimedia 

resource files. 
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Topics: 

 Automatic Transcript Timecoding 

 Sending a Timecoding Job to inData 

 Manual Transcript Timecoding 

Synchronizing a Digital Video Transcript is the process of placing timecodes on each line of 

the transcript so that the transcript advances in sync with the multimedia resource files 

during playback. There are four main options for synchronizing a Digital Video Transcript: 

AutoSync This uses the latest in voice recognition technology to 

automatically synchronize your transcript at a rate of 2-3 

times normal speed with 95% accuracy. This feature is 

designed to queue several Digital Video Transcripts in a single 

batch and to require minimal user interaction once the 

process is started. See Automatic Transcript Timecoding. 

RapidSync - Best 

Value! 

Just like AutoSync, except it synchronizes your transcript at a 

rate of up to 20 times normal speed with 98% accuracy. See 

Automatic Transcript Timecoding. 

Send to inData 

Upload your files to inData, and our experienced technicians 

will quickly synchronize and Q/C your transcript with a 100% 

satisfaction guarantee. You can even pick up your completed 

DVT's right in TimeCoder Pro! See Sending a Timecoding Job 

to inData. 

Manual 

Timecoding 

This is the process where a user listens to the multimedia 

resource file and presses the spacebar on each line of the 

transcript when the first word is spoken. See Manual 

Transcript Timecoding. 

  

Note: After a Digital Video Transcript has been synchronized, you should change the 

status to Synchronized but needs Q/C. 
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Topics: 

 Preparing for Automatic Synchronization 

 AutoSync™ Timecoding 

 RapidSync™ Timecoding 

Note: Before running your first automatic timecoding effort, please read each of the 

help topics above. This information will ensure that you obtain the best results possible from 

TimeCoder Pro and your Digital Video Transcript data. 
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Topics: 

 Preparing Multimedia Resource Files 

 Creating a Digital Video Transcript 

 Adding Multimedia Resource Files 

 Pre-Syncronization QC Check 

 Exiting All Other Applications 

First, prepare the multimedia resource files that will be used in the Digital Video Transcripts 

and encode them if necessary. 

 

Note: If you use Adobe  Premiere , you can import your raw DV (.AVI) footage 

into TimeCoder Pro and create a DepoView DVD to encode and author your 

DVD-Video in the same process. 

  

Copy all multimedia resource files onto the local hard disk of the TimeCoder Pro PC.  The 

multimedia files can reside on a shared network drive as long as the network throughput is 

adequate. It is not possible to automatically synchronize Digital Video Transcripts if the 

multimedia files reside on CD-ROM because TimeCoder Pro needs all of the multimedia 

resource files available while running an automatic synchronization job. 

Note: inData recommends that you do NOT automatically synchronize Digital Video 

Transcripts if the multimedia files contain very poor audio.  Surveillance tapes, phone tap 

audio and other such media often contain poor audio quality. These types of DVTs should be 

manually timecoded. For best results, make sure all speaking parties are using quality lapel 

microphones during videotaping of the deposition testimony. Properly mixing audio channels 

and levels will enhance the quality of the audio and produce more accurate synchronization 

in TimeCoder Pro. 

The next step in preparing for automatic timecoding is to create a Digital Video Transcript in 

TimeCoder Pro. If this process has already been performed, continue to the next step. 

For instructions on how to create a Digital Video Transcript, click here and then return to 

this topic. 
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After the Digital Video Transcript has been created, multimedia resources have to be added. 

All associated multimedia resource files must be added prior to auto timecoding a 

transcript. If this step has already been performed, continue to the next step. 

For instructions on adding multimedia resource files to the multimedia stream manager, 

click here and then return to this topic. 

The last step in preparing for automatic timecoding is to run a Pre-Synchronization QC 

Check. The main benefit of performing a QC Check prior to automatic timecoding is to 

determine whether TimeCoder Pro successfully identified all of the non-spoken text areas of 

the deposition (Header Pages, Introductions, Exhibit Indexes, Appearance Lists, Table of 

Contents, and Certification Pages) successfully. Sometimes these pages, if formatted in a 

non-standard way, can cause TimeCoder Pro to attempt to search for spoken text in these 

areas causing slower sync times and decreased accuracy. 

Simply choosing to run a Pre-Synchronization QC Check will cause TimeCoder Pro to mark 

all un-spoken lines within the transcript as gray in color, and all lines that it expects to 

timecode as red. If you discover that TimeCoder Pro has identified lines of the transcript in 

red that are actually non-spoken, simply highlight the line and press the "X" key to change 

the status of the line from "Needs to be timecoded" to "Does not require timecoding". 

Performing this quick QC Check will greatly improve speed and accuracy of your TimeCoder 

Pro Automatic Synchronizations. 

For instructions on performing a QC Check, click here and then return to this topic. 

Prior to running the automatic timecoding process, please make sure to close all programs, 

other than TimeCoder Pro.  Because automatic timecoding makes extensive use of your 

computer's processor and memory, closing all unnecessary applications will provide more 

efficient processing. 

For best results, do the following: 

 Close all programs, other than TimeCoder Pro, including Windows Explorer. 

 Close any Anti Virus or other like utilities that may be running within the Windows 

System Tray. See your windows user guide for more information on disabling items 

in the system tray. 

 Additionally, you may want to run the MSCONFIG application to disable all "Startup" 

programs.  Disabling startup programs will only load files necessary to run 

Windows. To disable the startup programs: 
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1. Click Start | Run and type MSCONFIG in the Open: box, as shown below. Click OK. 

 

2. The System Configuration Utility application will launch, as shown below.  Select the 

Selective Startup radio button and uncheck Load Startup Items.  Click OK to 

save the changes. 

 

3. You will be prompted to restart your system. Restart your system for the changes to 

take effect. 
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Note: AutoSync is not supported for MPEG-4, QuickTime, WMV, and WMA file types. 

  

To perform AutoSync timecoding 

1. Select Automatically Synchronize Digital Video Transcript(s)... from the File 

menu. 

 

2. Select one or more Digital Video Transcripts from the list. Click Select All to select 

all DVT's or Clear All to clear all selections.  Selecting multiple DVT's is especially 

efficient when processing overnight or over a weekend. 

3. Use the Up and Down buttons to put the DVT's in the order you would like them 

processed. 

4. Click Next to continue. 

 
IMPORTANT: Prices shown above are subject to change without Prior Notice by inData Corporation.  



TimeCoder Pro User Manual 
 

95 

5. Select AutoSync and click Next. 

Note:  If one or more of the multimedia resource files for any of the selected 

Digital Video Transcripts are not available, a window will appear showing a list of files 

that are unavailable. Select a file from the list and click Fix to open the Multimedia 

Stream Manager and replace the missing file. Click OK when you are finished. 

Repeat the process for any additional missing files until all of the corrections have 

been made. 

 

This window shows you how much your account will be charged to synchronize the 

DVT. 

Note:  If you do not have an active Internet connection you will not be able to 

continue past this point! In addition, if you have exhausted all of the Sync credits in 

your account, you will not be able to continue. On the File menu, click Login to 

Timecoding Account... and login to TimeCoder Pro Administrator to purchase 

additional Sync credits using the Fund Account tab. More Information 

6. Click Begin to start the auto timecoding process.  The AutoSync engine will run 

through several sub-routines during this process. The progress meter will be reset 

for each routine that is run. Depending on the speed of your system and the total 

running time of the DVT, this process could take a few hours. 
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7. When the AutoSync process is complete, the results will be displayed. 

 

8. Review the results and click OK to exit the Automatic Timecoding wizard.  Now that 

the timecoding process is complete, you will want to Q/C the timecodes and make 

any necessary adjustments. 

Note:  These results are also sent to the corresponding TimeCoder Pro Administrator 

account. 
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To perform RapidSync timecoding 

1. From the File menu, select Automatically Synchronize Digital Video 

Transcript(s).... 

 

2. Select one or more Digital Video Transcripts from the list. Click Select All to select 

all DVT's or Clear All to clear all selections.  Selecting multiple DVT's is especially 

efficient when processing overnight or over a weekend. 

3. Use the Up or Down buttons to put the DVT's in the order you would like them 

processed. 

4. Click Next to continue. 

 
IMPORTANT: Prices shown above are subject to change without Prior Notice by inData Corporation. 

5. Select RapidSync and click Next. 
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Note:  If one or more of the multimedia resource files for any of the selected 

Digital Video Transcripts are not available, a window will appear showing a list of files 

that are unavailable. Select a file from the list and click Fix to open the Multimedia 

Stream Manager and replace the missing file. Click OK when you are finished. 

Repeat the process for any additional missing files until all of the corrections have 

been made. 

6. This window shows you how much your account will be charged to synchronize the 

DVT. 

 

 

Note:  If you do not have an active Internet connection you will not be able to 

continue past this point. In addition, if you have exhausted all of the Sync credits in 

your account, you will not be able to continue. On the File menu, click Login to 

Timecoding Account... and login to TimeCoder Pro Administrator to purchase 

additional Sync credits using the Fund Account tab. More Information 

7. Click Begin to start the auto timecoding process.  The RapidSync engine will run 

through several sub-routines during this process. The progress meter will be reset 

for each routine that is run. Depending on the speed of your system and the total 

running time of the DVT, this process could take a few hours. 
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8. When the RapidSync process is complete, the results will be displayed. 

 

9. Review the results and click OK to exit the Automatic Timecoding wizard.  With the 

timecoding process completed, you will want to Q/C the timecodes and make any 

necessary adjustments. 

Note:  These results are also sent to the corresponding TimeCoder Pro Administrator 

account. 
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Topics: 

 Timecoding a Transcript 

 Editing Timecodes  

 Timecoding a Missed Line  

 Changing an Incorrect Timecode  

Timecoding a transcript is synchronizing the ASCII transcript to the multimedia file by 

setting time stamps on each line of the transcript. 

Note: Before beginning the timecoding process, ensure that the appropriate DVT has 

been created and that at least one of the corresponding multimedia files has been loaded. 

1. Open the desired DVT. 

2. Select the appropriate multimedia file from the Multimedia Selection Box. If there are 

no multimedia files to choose from, load the appropriate multimedia files. 

3. Find the place in the transcript where the selected multimedia file begins. To do this, 

click Play  on the Multimedia Control Box, listen to the first few words of the 

multimedia file and then search for those words in the ASCII transcript. 

Note: If you cannot locate the first words of the multimedia file, advance the 

multimedia file and try again since the transcription may begin further into the 

multimedia file. 

4. When you have found the beginning of the multimedia file in the transcript, verify 

that the blue highlighter bar is on the line of transcript that corresponds to the 

beginning of the multimedia file. Click the Seek to Start button  on the 

Multimedia Control Box to rewind the multimedia file to the beginning. 

5. Click Record  on the Multimedia Control Box to enter Timecoding Mode. 

6. Click Play on the Multimedia Control Box to begin playback of the multimedia file. 

7. When the multimedia file reaches the first word of the transcript line that is currently 

highlighted in blue, press the SPACEBAR. The current multimedia time is stamped on 

the left side of the transcript line, as shown below. 
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8. Continue this process until you reach the end of the multimedia file. If you miss a 

line or stamp a line incorrectly, use the appropriate keyboard commands to edit your 

mistakes (see Editing Timecodes below). 

Note: You must be in Timecoding Mode to edit timecodes.  To enable Timecoding 

Mode, click the Record button so that it is red. 

9. If there are additional multimedia files, repeat steps 2 through 8 until the entire 

transcript has been timecoded. When the entire transcript has been timecoded, you 

can export the Digital Video Transcript. 

This section explains how to correct the two most common errors made while timecoding a 

transcript. You must be in Timecoding Mode in order to edit timecodes. To enable 

Timecoding Mode, click the Record button so that it is red. 

Note: When editing timecodes, ensure the timecodes are in chronological order. For 

example, the timecode 00:00:15 cannot be preceded by 00:00:30. 
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If you do not press the spacebar in time to place a timecode on a line of transcript, simply 

rewind the multimedia file by pressing the LEFT ARROW key on your keyboard. When the 

multimedia file reaches the appropriate position again, press the SPACEBAR and continue 

timecoding as you normally would. 

If you press the SPACEBAR at the incorrect time or on the incorrect line, pause the 

multimedia file by clicking Pause  or by selecting Pause from the Multimedia menu. 

Then use the UP ARROW or DOWN ARROW on your keyboard to move the highlighter to the 

line with the incorrect timecode. Press the DELETE key on your keyboard to erase the 

timecode. Rewind or advance the multimedia file as necessary and click Play or select Play 

from the Multimedia menu. When the multimedia file reaches the appropriate position 

again, press the SPACEBAR and continue timecoding as you normally would. 

Note: If you are in Timecoding Mode and the highlight bar is on a line that already has 

a timecode, pressing the SPACEBAR will overwrite the old timecode with a new timecode 

that corresponds to the current time in the Multimedia Control Box. 
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inData's expert technicians can quickly synchronize your DVTs and and perform Q/C to save 

you time. 

To send a job to inData 

1. First, upload the files to inData. 

2. Use TimeCoder Pro Administrator to monitor the status of outsourced jobs. 

3. Use TimeCoder Pro to pick up (download) Digital Video Transcripts from inData. 
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For maximum efficiency and convenience, you can send your timecoding job to inData. Our 

experienced technicians will quickly synchronize and Q/C your Digital Video Transcripts and 

return them to you ready for export. 

 

Notes:   

   Send to inData is not supported for MPEG-4, QuickTime, WMV, and WMA file types. 

   Make sure you have enough sync credits prior to sending a timecoding job to 

inData. In addition, please read the Help topic Prepare Digital Video Transcript for 

Automatic Sync prior to using this feature for the first time. 

  

To upload files to inData 

1. From the File menu, select Automatically Synchronize Digital Video 

Transcript(s).... 

 

2. Select one or more Digital Video Transcripts from the list. Click Select All to select 

all DVT's or Clear All to clear all selections.  Selecting multiple DVT's is especially 

efficient when processing overnight or over a weekend. 

3. Use the Up or Down buttons to put the DVT's in the order you would like them 

processed. 

4. Click Next to continue. 
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IMPORTANT: Prices shown above are subject to change without Prior Notice by inData Corporation. 

5. Select Send to inData and click Next. 

 
IMPORTANT: Service level options shown above are subject to change without Prior Notice by inData 

Corporation. 

  

6. Select the desired delivery speed and rate. Click Next to continue. 
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7. Enter your contact information. Click Next to continue. 

Note:  If one or more of the multimedia resource files for any of the selected 

Digital Video Transcripts are not available, a window will appear showing a list of files 

that are unavailable. Select a file from the list and click Fix to open the Multimedia 

Manager and replace the missing file. Click OK when you are finished. Repeat the 

process for any additional missing files until all of the corrections have been made. 

 

This window shows you how much your account will be charged to synchronize and 

Q/C the DVT. 

Note:  If you do not have an active Internet connection you will not be able to 

continue past this point! In addition, if you have exhausted all of the Sync 

timecoding credits in your account, you will not be able to continue. On the File 

menu, click Login to Timecoding Account... and login to TimeCoder Pro 

Administrator to purchase additional Sync credits using the Fund Account tab. More 

Information 
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8. Click Begin to begin compressing the files and sending them to inData. 

 

9. Click OK when the files have been sent. You can track the progress of the 

outsourced Digital Video Transcripts in your TimeCoder Pro Administrator account. 

After the Digital Video Transcripts have been processed, they will be ready for 

pickup. 

 

Note:  These results are also sent to the corresponding TimeCoder Pro Administrator 

account.  

  

  



TimeCoder Pro User Manual 
 

108 

After you send a job to inData, you can monitor the status from a Web browser on any 

computer using TimeCoder Pro Admininistrator. In the Account Activity area, you can filter 

the grid to show only jobs with a specified Status (i.e. File Arrival, In Production, or Ready 

For Pickup) and select "OutSource" in the Type column. 

 

  

When you view items in the Account Activity grid, look at the Status column. Initially after 

you send the job to inData, the Status column will show "File Arrival": 

 

  

When the job is complete and ready for pickup (download), the Status will show "Ready for 

Pickup": 

 

 

  

After you pickup (download) the DVT, the Status will show "Successful": 
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Timecoding jobs that have been sent to inData for processing can be retrieved directly from 

TimeCoder Pro when they are complete. 

  

To pickup outsourced Digital Video Transcripts 

1. Select Pickup outsourced Digital Video Transcript(s) from the File menu. 

2. TimeCoder will begin checking for outsourced Digital Video Transcripts that are ready 

for pickup. 

 

3. Outsourced DVTs that are ready will begin to download.  When the progress bar 

reaches the end, the DVTs that are ready for pickup will be displayed with a green 

indicator icon.  Any DVTs that are not ready for pickup will be displayed with a red 'X' 

icon, as shown below. 
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4. Click OK to close the dialog.  You can now open the completed DVT and export to a 

DepoView volume. 
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Topics: 

 Q/C Timecodes 

 Quality Control (Q/C) Check Results 

 Extrapolating Timecodes 

 Adjusting Timecodes 

After a Digital Video Transcript has been synchronized, you should perform quality control 

(Q/C) checks to ensure that the timecodes are accurate and the multimedia resource files 

are loaded properly.  For automatically synchronized DVT's, you should Q/C the timecodes 

and then run the Quality Control Check. For manually synchronized DVT's, you only need to 

run the Quality Control Check. Extrapolating Timecodes and Adjusting Timecodes are 

optional. Once the Q/C process is complete, the Digital Video Transcript is ready for export. 

Note: After a Digital Video Transcript has been checked for quality, you should change 

the status of the Digital Video Transcript to FINISHED AND READY FOR EXPORT. 
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Topics: 

 Enabling Q/C Mode 

 Marking Missing Timecodes 

 Reviewing Questionable Timecodes 

TimeCoder Pro Q/C feature allows the user to quickly review and update timecodes after 

completing an Sync process.  The Q/C feature will clearly mark, in red, each line that does 

not contain a timecode.  Once you have finished reviewing the transcript and making 

corrections, you should run the Quality Control (Q/C) Check. 

Note:  Normally, only transcript pages containing Question and Answer dialogue are 

included in the Q/C range.  Transcript title pages and certification pages are not included 

when verifying timecoded lines. 

To enable Q/C mode, first open the Digital Video Transcript you wish to check.  Then, click 

the  button on the toolbar or select the Enable Quality Control (Q/C) Mode from 

the Edit menu. 

When Q/C mode is enabled, any transcript dialogue lines that do not have a timecode are 

marked in red.  Lines that have been marked as yellow contain questionable timecodes, as 

shown below. 
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Note: The light blue colored line indicates the current position within the 

Digital Video Transcript.  

1. Begin playback of the Digital Video Transcript by clicking the PLAY button on the 

Multimedia Control Box.  

2. Enable Timecoding mode by clicking the record button   on the Multimedia Control 

Box.  This button will turn red when the Timecoding mode is enabled. 

3. Use either the  button or press ALT+N to move to the next missing 

timecode.  Arrow up to the previous line and press ENTER to commence playback 

from the timestamp located directly above the marked (red) line.  This will give the 

Q/C operator ample time to mark the timestamp for the red line. 

4. Press the SPACEBAR to timestamp the red line.  The SPACEBAR should be pressed at 

the first spoken word of the line. 

5. The red line will turn white and the playback will continue, as shown below. 
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6. Move the next missing timecode by pressing ALT+N again.  Use the SPACEBAR to 

timestamp the line. 
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7. Repeat the process until all of the red lines have been timestamped. 

Note: The grey colored line indicates the a non-spoken portion of the Digital Video 

Transcript.  The transcript title, appearances, and certification areas will usually be marked 

as a grey line.  These areas are automatically defined during import of the source transcript 

and are not used during the Sync process.  However, if you would like to place a timestamp 

on a non-spoken portion of the Digital Video Transcript, select the line you would like to 

timestamp and press the SPACEBAR to timestamp it as you would any other line. 

  

TimeCoder Pro will mark transcript lines which may contain questionable timecodes in 

yellow.  These timecodes should be reviewed for accuracy.  In most cases, these timecodes 

will be acceptable and produce accurate scrolling text.  

1. Use the Q/C Accuracy Threshold slider, which is located within the TimeCoder Pro 

tool bar, to adjust the number of lines marked in yellow. 
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The Q/C Accuracy Threshold slider is used to set the timecode accuracy that is 

tolerable for your Digital Video Transcript, as shown in the image above.  For 

example, if you want to check all timecodes that are less than 100% accurate, you 

would set the slider bar at 100%. Slide to the right to increase the level of accuracy 

you require, thus increasing the number of questionable (yellow) transcript lines 

shown. Slide the bar to the left to decrease the accuracy you require, thus 

decreasing the number of questionable (yellow) transcript lines shown. 

2. After you have set the accuracy threshold, navigate to the first questionable line of 

transcript text (using 'N' key).  The TimeCoder Pro status bar will indicate the 

confidence score, as shown below.  Double-click on the line just before it to advance 

the multimedia to that point. 

 

3. Verify that you are not in Timecoding Mode (the Record button on the Multimedia 

Control Box should be blue, not red), and click Play to begin playback. 

4. Watch the blue highlighter bar to ensure that it advances to each questionable 

(yellow) line at the correct time.  If the questionable timecodes are accurate, to an 

acceptable degree, they do not need to be timestamped again, and you can begin 

reviewing the next questionable timecodes. 

5. If the questionable timecodes are not acceptable, click the Pause button to pause 

the multimedia. 

6. Click Record to enter Timecoding Mode (the Record button should be red). 

7. Double-click on the line above the line with the unacceptable timestamp to rewind 

the multimedia to that point. 

8. Click on the line with the unacceptable timecode so that it has the blue highlighter 

bar on it, and click Play to begin playback. 

9. When you hear the first word of the line highlighted in blue, press the SPACEBAR to 

timestamp it. The line will turn to the normal (white) color. 

10. Repeat the process to review the remaining questionable timecodes in the transcript. 
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When the Quality Control (Q/C) Check is performed, TimeCoder Pro performs the following 

tests: 

 Chronological Multimedia Check 

 Out-of-Sequence Timecode(s) Check 

 Missing Timecode(s) Check 

To use the Quality Control (Q/C) Check Results 

1. Click the   tool or select Perform Quality Control (Q/C) Checks from the Edit 

menu 

2. Check the window that appears closely. 

  

a. If all of the check pass the following screen will appear: 

 

b. If one, or all of the checks fail, a screen similar to the one shown below will appear: 
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Note: The example above shows that all 3 checks failed. The window that is produced 

by your results can have any combination of check failures. 
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To verify that the multimedia resource files are sorted in chronological order, do one of the 

following: 

 Select the  tool button 

 Select Perform Quality Control (Q/C) Checks from the Edit menu. 

When the Quality Control (Q/C) Check is performed, the chronological order of the 

associated multimedia files is checked. When it appears that the media files are not in the 

correct order in relation to the timecoded transcript, a warning will be displayed. 

 

Use the Up/Down buttons in the Multimedia Manager to correct the order of the multimedia 

resource files. 
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To check whether there are any timecodes that are out of order, do one of the following: 

 Select the  tool button 

 Select Perform Quality Control (Q/C) Checks from the Edit menu. 

When the Quality Control (Q/C) Check is performed, a sequence check is performed to 

verify that the timecodes run in sequential order. When it appears that there are one or 

more timecodes that are not in the correct sequence in relation to the previous and next 

timecodes, a warning will be displayed. 

To correct out-of-sequence timecodes 

1. Click Begin Q/C, which will enable Q/C mode and jump to the first timecode that is 

out of sequence. 

2. Verify that Timecoding Mode is enabled by clicking the Record button  on the 

Multimedia Control Box.  This button will turn red when Timecoding Mode is enabled. 

3. Double-click the line before the line that is out of sequence to advance the 

multimedia to that position. 

4. Click on the line that is out of sequence so that it has the blue highlighter bar on it, 

and press the Play button. 

5. When you hear the first word of the line highlighted in blue, press the SPACEBAR to 

timestamp it. 

6. Use either the button or press ALT+N to move to the next timecode that is out of 

sequence. 

7. Continue until all the timecodes that were out of sequence have been checked. 

8. Click the  tool button to verify that the adjustments made were correct, if they 

were a window similar to below will appear: 
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To check whether there are any missing timecodes, do one of the following: 

 Select the  tool button 

 Select Perform Quality Control (Q/C) Checks from the Edit menu. 

When the Quality Control (Q/C) Check is performed, a check is performed to verify that all 

the lines have been timecoded. When it appears that there are lines that have not been 

timecoded a warning will be displayed. 

 

 

To correct missing timecodes 

1. Click Begin Q/C, which will enable Q/C mode and jump to the first line that is 

missing a timecode. 

2. Check that Timecoding Mode is enabled by clicking the Record button  on the 

Multimedia Control Box.  This button will turn red when Timecoding Mode is enabled. 

3. Double-click the line before the line that is missing a timecode to advance the 

multimedia to that position. 

4. Click on the line that is missing a timecode so that it has the blue highlighter bar on 

it, and click the Play button. 

5. When you hear the first word of the line highlighted in blue, press the SPACEBAR to 

timestamp it. 

6. Use either the button or press ALT+N keystroke to move to the next line that is 

missing a timecode. 

7. Continue until all the lines that were missing a timecode have been checked. 
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8. Click the  tool button to verify that the adjustments made were correct, if they 

were a window similar to below will appear: 
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TimeCoder allows you to adjust timecodes for the entire transcript, assuring that a correct 

synchronization is made.  

1. Click on the first timecoded line of the transcript that you would like to adjust so that 

the blue highlighter bar is on it. 

2. Select Adjust Transcript Timecodes... from the Edit menu. 

 

3. Below the What would you like to adjust? question, select from the following options: 

Current Position 

to End of 

Transcript 

Adjusts only the timecodes from the current position (as 

indicated by the blue highlighter bar) to the end of the 

transcript. This option allows you to adjust only the part of 

the transcript that is improperly timecoded. 

Entire Transcript Adjusts all timecodes in the transcript. 
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Below the How would you like to adjust the transcript? question, select from the 

following options: 

Synchronize 

Current Position 

to Audio/Video 

Adjusts the timecode at the current position (as indicated by 

the blue highlighter bar) to the current position of the 

audio/video and then adjusts the other timecodes in the 

transcript by the same increment.  

For example, if the timecode on the current line is 

00:09:19:000 and the current position of the audio/video is 

00:09:20:000, all the timecodes would be adjusted by one 

second. If you select this option, make sure that the 

audio/video is at the desired point before continuing. 

Adjust Current 

Position by (#) 

Seconds 

Adjusts timecodes by the number of seconds specified. Enter 

a negative number to adjust the timecodes back or a positive 

number to adjust the timecodes forward. 

4. After selecting your options, click Next. 
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5. Select Adjust to begin adjusting the timecodes. 

 

6. When the adjustment is complete, click Next to continue. 

 

7. Click OK to complete the adjustment process. 
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TimeCoder Pro has an Extrapolate Timecodes function that will automatically "fill" gaps 

between timecoded lines. This feature is handy for automatically populating missing 

timecodes.  However, this feature should only be used when there are 1-2 lines in a row 

missing timecodes.  Attempting to extrapolate a Digital Video Transcript with large blocks of 

untimestamped lines will result in poor synchronization during playback. 

To extrapolate timecodes 

1. select Extrapolate Transcript Timecodes... from the File menu. 

 

2. Click Extrapolate. 

 

3. When the extrapolation is complete, click OK. 
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  Topics:  

 Adding Exhibits 

 Adding an Exhibit Alias 

 Removing an Exhibit or Alias 

 

TimeCoder Pro allows you to link exhibits to a Digital Video Transcript and automatically 

finds all references to the exhibit within the transcript.  When the Digital Video Transcript is 

viewed in DepoView, a link will appear in the column next to the transcript line where the 

exhibit is mentioned.  From DepoView, you can export a Digital Video Transcript with linked 

exhibits into TrialDirector, CT Summation Enterprise or iBlaze, or LiveNote 9.0 (or higher). 

1. To open the Linked Exhibits window, select Linked Exhibits... from the View menu. 

 

2. Click Add Exhibits. 
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3. Select the exhibit you wish to add and click Open. 

 

4. TimeCoder Pro automatically finds all page:line references to the exhibit in the 

transcript, based on the filename.  If any of the references are invalid, click the 

checkmark next to the invalid reference to omit it when the Digital Video Transcript 

is exported.  To remove the checkmark from all of the references, click Clear All.  To 

put a checkmark next to all of the references, click Select All. 

If an exhibit has another name by which it is referenced in the transcript, such as its title, 

you can add an "alias" to the exhibit. 

1. Select Linked Exhibits... from the View menu to open the Linked Exhibits window if 

it is not already open. 

2. Select the exhibit you want to assign an alias to, and click Add an Alias. 
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3. Enter the exhibit alias and click OK. 

 

4. TimeCoder Pro automatically finds all page:line references to the exhibit in the 

transcript, based on the alias.  If any of the references are invalid, click the 

checkmark next to the invalid reference to omit it when the Digital Video Transcript 

is exported.  To remove the checkmark from all of the references, click Clear All.  To 

put a checkmark next to all of the references, click Select All. 

1. To remove an exhibit or exhibit alias, select the exhibit or alias you would like to 

remove and click Remove Selected. 

 

2. Click Yes to remove the exhibit or alias.  The exhibit or alias and all of its associated 

page:line references will be removed. 

Note: If you remove an exhibit, all of its aliases and corresponding page:line 

references will be removed as well. 
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Topics: 

 Finding a Text/Phrase 

 Finding a Page/Line  

 Finding a Timecode  

TimeCoder Pro allows you to search a transcript by Text/Phrase, Page/Line, or Timecode. 

The Text/Phrase search allows you to find specific text in the transcript. 

1. To search by Text/Phrase, select Find... from the Edit menu and select the 

Text/Phrase tab on the Find dialog window. 

 

2. Type in the text or phrase you want to search for in the Find What: box. 

Note: TimeCoder will only find text that exists within one line of the transcript. 

In other words, if there is a carriage return separating the phrase, it will not be 

found by TimeCoder using the Text/Phrase option. 

3. Select the Match Case option if you would like the search to be case sensitive. 

4. Select whether you want TimeCoder to search Up or Down from the current position 

of the cursor in the transcript. 

5. Click Find Next to begin the search. The text in the Transcript Window moves to 

display the first occurrence of the search text. 

  

Note: You may need to move the Find dialog window if it is covering the 

transcript. The “found” text may be behind it. 
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6. If this is not the specific instance you are looking for, click Find Next to move to the 

next occurrence in the search. 

The Page/Line search allows you to find a particular page and line number in the transcript. 

1. To search by Page/Line, select Find Page/Line from the Edit menu or select the 

Page/Line tab on the Find dialog window. 

 

2. Type the page and line number you want to jump to in the transcript or use the Up 

and Down arrows on your keyboard to increase or decrease the current page or line 

number selection. 

3. Click Find Next to jump to the selected location in the transcript. 

Note: Specifying a line number is optional. 

The timecode search allows you to find a timestamp in the transcript. 

1. To search by timecode, select Find Time from the Edit menu or select the 

TimeCode tab on the Find dialog window. 
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2. Type in the desired time or use the Up or Down arrows to increase or decrease the 

current time selection. 

3. Click Find Next to jump to the selected timestamp in the transcript. 
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Topics: 

 Applying Page / Line Formatting 

 Applying Word Wrapping 

Before you create a DVT, you have the option to format your original transcript so that it 

loads properly into TimeCoder Pro. The formatting wizard will apply page and line formatting 

to a transcript or unformatted text file and also apply word wrapping. 

Applying Page/Line Formatting to a Transcript 

Follow these steps to format a transcript: 

1. Close any Digital Video Transcript that may be open. 

2. Select Apply Page/Line Formatting... from the Tools menu. 

 

3. Enter the folder and filename of the original transcript you want to format, or click 

Browse to find the transcript.  
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a. If you select Browse, the following window appears: 

 

b. Select the transcript you wish to format and click Open. 

4. When the desired folder and filename are selected, click Next. 

5. TimeCoder Pro will automatically determine the page and line information for the 

specified transcript. Verify the information listed and modify the values as necessary. 

If you need to view the transcript, click Edit and the transcript will open in WordPad 

for your review. 

 

6. Click Next to continue. 
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7. In order to preserve the original transcript file, enter a different destination folder 

and filename for the formatted transcript, or click Browse to select the destination 

folder and filename.  

b. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the formatted transcript. 

Click Save to save the selection. 

8. If you want the timecodes from the original transcript to be in the formatted 

transcript, select the Output with timecodes option. 

9. Click Next to continue. 
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10. Click Format to continue. When the progress bar reaches the end, the format is 

complete. 

 

11. Verify that the operation was completed successfully and that there are no errors. 

12. Click OK to complete the formatting process. 

TimeCoder will assist you in applying word wrapping to an unformatted text file. 

To apply word wrapping, 

1. Close any Digital Video Transcript that may be open. 

2. Select Apply Word Wrapping... from the Tools menu. 
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3. Enter the folder and filename of the original transcript you want to format, or click 

Browse to find the transcript.  

a. If you select Browse the following window appears: 

 

b. Select the transcript you wish to format and click Open. 

4. When the desired folder and filename are selected, click Next. 
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5. Determine how many characters you would like to appear on each line and make any 

necessary adjustments. If you need to review the original file, click Edit and the file 

will be opened in WordPad for your review. 

6. If you would like whitespace over a certain number of characters to be removed in 

the formatted transcript, select the Remove leading whitespace over option and 

specify the minimum number of whitespace characters that must be in a row for the 

whitespace to be removed. 

7. Click Next to continue. 

 

8. In order to preserve the original transcript file, enter a different destination folder 

and filename for the formatted transcript, or click Browse to select the destination 

folder and filename.  

b. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the formatted 

transcript. Click Save to save the selection. 

9. When the desired folder and filename are selected, click Next. 
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10. Select Format to continue. When the progress bar reaches the end, the format is 

complete. 

 

11. Verify that the operation was completed successfully and that there are no errors. 

12. Click OK to complete the formatting process. 
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You can save ready-to-view synchronized transcripts and video from TimeCoder Pro to CD 

or DVD. Both formats enable your clients to download free DepoView software to search for 

keywords in transcripts, view video, create video clips for trial, print condensed transcripts, 

send selected segments to Microsoft PowerPoint, and more. DepoView DVD gives your 

clients the added flexibility to view just the transcript or the synchronized transcript and 

video on a standalone DVD player (as well as on a computer DVD drive), and to jump to a 

selected page in the in transcript or video. 

The following chart details the differences between both formats. 

  

DepoView 6 Software DepoView DVD  

(includes DepoView software) 

Description 

Video review software that enables the user to 

view a video deposition, the associated 

transcript, and exhibits on a 

computer.   Features include:  Search for key 

words in the transcript, create video clips for 

trial, print full or condensed transcripts, export 

entire video or segments to other popular 

software programs, take snapshots of video 

frames, and more. 

Hybrid DVD/software tool for 

viewing video depositions 

(patent-pending). User can view 

video depositions and associated 

transcripts on a standard DVD 

player or computer.   Includes 

download of DepoView 

software.  When played with a 

standard DVD player, DepoView 

DVD provides three options to the 

user:  (1) review the video 

deposition; (2) read the entire 

transcript, or (3) jump directly to 

a selected page in the transcript 

or video. 

How it Works 

DepoView data files are provided to your client 

on a CD-ROM or DVD-ROM data disk.  When 

the user inserts the disk into their PC, they are 

directed to a Web page to download DepoView 

software. 

A DVD is provided to your client. 

User can immediately play DVD 

on any standard DVD 

player. When the user inserts the 

DepoView DVD into a PC, they are 

directed to a Web page to 

download complimentary 

DepoView software.  

Link to Images  DepoView Software Images  DepoView DVD Images  

  

http://www.indatacorp.com/flash/DepoView_Demo.htm
http://www.indatacorp.com/flash/DepoView_Demo.htm
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 Features Important to You 

Cost to Export 

Free $5 per copy of a deposition 

successfully burned. (Note that 

the fee is only $5 even if the 

deposition spans several DVDs.)   

Marketing 

Advantages 

Your company's logo appears in the 

software's opening screen.  Your 

company's information appears under the 

"Help" menu and on  the Web page when 

user downloads DepoView software. 

All items mentioned under 

DepoView software are 

available.  Your company's logo 

and contact information also 

appears in the opening screen of 

DepoView DVD.   

File Types 

Supported 
MPEG-1, MPEG-2, MPEG-4*, WMV, WMA, MP3, 

WAV 

MPEG-1, MPEG-2, VOB 

MPEG-2 Codec 

included? 
No Yes 

Encode & Sync 

Directly from 

AVI/DV files? 

No. You must convert AVI/DV files to 

MPEG format first before you use 

TimeCoder Pro to synchronize the videos 

with the transcripts. (May require 

hardware MPEG encoders.) 

Yes. You can immediately 

synchronize AVI/DV files with 

transcripts. No prior conversion is 

needed, which eliminates the 

need to purchase additional 

hardware MPEG encoders. 

Data Storage 
700 MB per CD. (A full day of depositions 

may require several CDs.) 

8.5 GB of data on each dual-layer 

DVD (equivalent to one full day of 

depositions). 

Features Important to Your Clients 

Subtitle Support 
Yes, in preview screen only. Yes.  User can enable/disable 

subtitles using the DVD player 

controls. 
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Third-Party 

Integration 

Exports full video or clips to inData 

TrialDirector, CT Summation, LiveNote, and 

Microsoft PowerPoint. 

All export options mentioned 

under DepoView software are 

available.  The following load files 

are automatically included on the 

DVD for import into other 

applications: 

 .AMI  (AMICUS transcript) 

 .CMS (inData TrialDirector 

standard load file) 

 .OLL (inData TrialDirector 

exhibits load file) 

 .MDB (Sanction load file) 

 .SBF (CT Summation transcript, 

exhibit load file) 

 .DII (CT Summation load file) 

 .PTF/.VID (LiveNote load file) 

 .EXH (LiveNote exhibits load 

file) 

 .PTS (Timaro Post-Production 

Timestamp file) 

 .TXT (ASCII transcript) 

 .XML (OpenDVT XML) 

*MPEG-4 support is a new feature of DepoView 6 

When you have determined the best format for your client, click the appropriate link below 

to view step-by-step instructions: 

Exporting to DepoView (CD) 

Creating a DepoView DVD 

  

 

More Information: 

 Distributing DepoView Volumes 

 Supported Multimedia File Types 

 Installing the MPEG-2 Codec 
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You can create DepoView DVDs to enable your clients to view their synchronized transcripts 

from any standalone DVD player or computer with DVD drive. For each deposition you 

successfully export to DVD, $5 is deducted from your account to cover licensing charges. 

(Note that the fee is only $5 even if the deposition spans several DVDs.) 

Before you create a DepoView DVD 

 Obtain blank DVD disc(s). If your computer is equipped with more than one DVD 

burner, you can burn multiple copies simultaneously. inData recommends you use DL 

(double layer) DVD discs, which can hold approximately 4 hours of deposition video 

each without any transcoding. 

 Review DepoView and DepoView DVD Feature Comparison to ensure you understand 

the DepoView DVD features. 

 Review the system requirements to ensure your system meets or exceeds them. 

 Ensure the multimedia files synchronized with the transcript are supported for export 

to DepoView DVD. 

 If your transcript includes multimedia files that exceed the capacity of one DVD disc, 

use the Multimedia Manager to group the files to include on each disc. 

 Close all other programs on your computer. If your transcript includes large 

multimedia files and/or transcoding is required, run the burn process at night. 

To create a DepoView DVD 

1. Open a Digital Video Transcript that has already been synchronized and reviewed for 

quality control. These transcripts are usually marked as “Finished and ready for 

Export”. 

2. On the File menu, point to Export to and then click DepoView DVD volumes…. 

3. Enter the number of copies you want to burn to DVD. You will be charged $5 per 

copy of a deposition.  
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4. The program provides an estimate of charges before beginning the burning process. 

You will only be charged for DVDs that are successfully burned. 

 

 

5. The DepoView DVD Creator screen appears. Review the information for accuracy. 

This information will ultimately appear on the home page of the DepoView DVD that 

you burn. 

6. If needed, you can edit the case number (e.g. insert the case name in its place), 

deponent’s name, date, and your company information. To save your changes in 

each of these fields, press ENTER after you type your changes. 
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7. If you are using a double-layer (DVD9) disc and you want the entire deposition to be 

burned on one disc, select Keep deposition on one DVD. (If you change the disc 

loaded in the burner, click the Refresh button to enable this option.) 

The estimated completion time appears in the lower righthand corner. 

 

Note: If you select this option, TimeCoder Pro may need to transcode 

your video to make it fit on one DVD. This could affect the quality of the 

video and may take longer to burn. For example, it takes 60-70 minutes 

to transcode 2 hours of MPEG-2 video. 

8. Do not change the Write Speed unless you have previously encountered a buffer 

under-run and need to lower the speed. 

The default Write Speed is automatically determined by the type of media mounted 

in the drive and the performance of the DVD burner. 

9. Click the Burn DVD button. The program begins burning your deposition to DVD. On 

average, burning takes 8-20 minutes per DVD disc, depending on the source file and 

amount of necessary transcoding. You can burn multiple copies simultaneously if you 

have multiple DVD burning devices connected to your computer. 
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10. When the burning process is complete, you are notified of the actual charges to your 

account. The amount charged to your account is displayed in TimeCoder Pro 

Administrator on the Account Activity tab. 

11. Your DepoView DVD is now ready to play in any standard DVD player or personal 

computer equipped with a DVD drive. 

Each DepoView DVD includes the MPEG-2 codec (necessary to accurately view any 

MPEG-2 files included on DepoView DVDs), and a complimentary download of 

DepoView software for your clients. The codec is automatically installed when using 

DepoView software, or your client can install the MPEG-2 codec manually if needed. 
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You can replace the default inData logo that appears at the bottom right of the DepoView 

DVD menu page with your company logo. Once you complete the steps below, your logo will 

be used each time you create a DepoView DVD. 

To include your logo 

1. Create a bitmap graphic that is 72 DPI and 280 x 120 pixels in size. 

2. Save it as Logo.bmp.  

3. Copy the Logo.bmp file to the VendorData folder. 

By default, this location is C:\Documents and Settings\All Users\Application 

Data\inData\inDVDDepo\5.x\VendorData 

4. Click Yes to confirm you want to overwrite the existing file. 
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You or your clients can play DepoView DVDs on a computer equipped with a DVD drive, or 

on any standard DVD player. 

When loaded on a PC, the user is directed to a Web page to download complimentary DepoView 

software.  Each DepoView DVD also includes the MPEG-2 codec (necessary to accurately view 

any MPEG-2 files included on DepoView DVDs). The codec is automatically installed when 

using DepoView software, or your client can install the MPEG-2 codec manually if needed. 

When played with a standard DVD player, DepoView DVD provides three options to the user:  (1) 

review the video deposition, (2) read the entire transcript, or (3) jump directly to a selected page in 

the transcript or video. 

When the user reviews the video deposition, subtitles corresponding to the transcript text appear at 

the bottom of the screen against a semi-opaque area designed to make the text easy to view 

regardless of the video background color and any camera date/time indicators. Each line of subtitle 

text includes a Page:Line number reference to the location within the transcript. 

The following images show the DVD menus. 

Figure 1: DepoView DVD Main Menu 
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Figure 2: Page Selection 

 

  

Figure 3: View Transcript        
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Before you export, review the DepoView and DepoView DVD Feature Comparison to ensure 

you select the best format to meet you and your clients' needs. 

When a synchronized transcript is exported to a DepoView volume, a set of files is created 

so that the volume can be burned to CD and distributed to end users. When placed in a CD 

drive, a DepoView volume will automatically launch the DepoView application or prompt the 

user to download if it has not already been installed.  Then, the synchronized transcript will 

play automatically. 

 

Note: Attached exhibits are created via the Linked Exhibits feature in 

TimeCoder Pro. When you export a DepoView volume, the linked exhibits are 

copied to the 'Exhibits' folder.  The CT Summation (*.dii), TrialDirector (*.oll) 

and LiveNote (*.exh) files will then include the attached exhibit information. 

  

To export a Digital Video Transcript to a DepoView Volume 

1. Open the synchronized Digital Video Transcript (DVT). 

Typically, the status of the transcript is “Finished and ready for Export”. 

2. On the File menu, point to Export to, then click DepoView volume(s). 

  

 

Note: If one or more of the multimedia files is not available, you will 

receive an error message. If the files are stored on more than one CD, 

move them to a drive. Make sure all of the multimedia files are available 

and then try again. 

3.   

4.  

5. Enter or browse to a destination folder for the DepoView volume(s). Then, click 

Next. 
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The export path can be on a local disk, network drive or a UNC path. inData 

recommends that you verify the export path has enough drive space for the 

transcript and multimedia files. 

  

6. If your synchronized transcript includes more than one multimedia file, you are 

prompted to select one of the following options: 

 Single volume - Select if you plan to put all files on one CD 

 One volume for each multimedia file - Select if your multimedia files each 

approach the capacity of a CD 

 One volume for each multimedia group - Select if you have created 

groups of multimedia files to include on each CD in the Multimedia Manager 

Click Next. 

 

Note: TimeCoder Pro will automatically perform the Quality Control 

(QC) check. If there are any problems with the synchronized transcript, 

the Quality Control (QC) Check Results dialog box will appear, allowing 

you to correct the problems. 

7. An icon   appears for each volume. Ensure the volumes you want to export are 

selected. Then, click Next. 

The Volume Name is created based on the deponent's First Name/Last Name, the 

Deposition Date (MM/DD/YY), and the Deposition Part. (If the multimedia file resides 

on a CD, the CD name is used by default.) 

 

Single Volume Export 

 

Multiple Volume Export 

  

8. A screen advising you to include linked exhibits for CT Summation Enterprise or 

iBlaze users appears. If the transcript includes linked exhibits, you should choose to 

include them. Click Next to continue. 
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9. Click Export. During the export process, each multimedia file is copied to the 

destination path. Depending on file sizes and the number of volumes, this process 

may take several minutes or longer. 

 
  

10. When the export process is complete, review the results to ensure no warnings were 

issued. Click OK to close the wizard. 
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11. Exploring the destination folder will reveal the folder(s) associated with each 

DepoView volume.  The examples shown below demonstrate the output files for a 

single and a multiple volume export. 

  

 
Single Volume Export 

Results 

 
Contents of Single 

Volume Export 

 
Multi-Volume Export 

Results 
 

Contents of Multi-

Volume 

Export 

12. When exporting as a single volume, a single output folder is created for the 

DepoView volume.  All of the multimedia resource file(s) are included within the 

'Media' folder.  When exporting as multiple volumes, a separate output folder is 

created for each multimedia resource file.  Each output folder contains a single 

multimedia resource file within the 'Media' folder.  Therefore, each output folder (ex. 

MP072195A, MP072195B etc.) is considered a separate DepoView volume when 

burning to CD/DVD-ROM. 
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Topics: 

 Editing Vendor Information 

 Updating Vendor Graphic 

 Burning DepoView Volume to CD 

 DepoView Information 

After a DepoView Volume has been exported, it can be burned to CD/DVD-ROM and 

distributed to a client.  This section discusses information that is relevant to DepoView 

distribution. 

During the installation of TimeCoder Pro, you are prompted to enter information about your 

company on the Vendor Information screen. When you create a DepoView volume, this 

information is displayed on the main DepoView screen when the transcript is viewed.  All 

produced DVT Volumes that include the DepoView application will display this information.  

 

Note:  The installation will detect the existing Vendor Information from TimeCoder 4.x 

if it is already installed.  

If this information needs to be changed prior to exporting a DepoView Volume, perform the 

following steps. 

1. Open the Vendor.dat file to edit any information. The Vendor.dat file is located, by 

default, in the path listed below. 

C:/Documents and Settings/All Users/Application Data/inData/TimeCoder Pro 

6/DepoView/Vendor.dat 

file:///C:/Documents%20and%20Settings/All%20Users/Application%20Data/inData/TimeCoder%20Pro%205/DepoView/Vendor.dat
file:///C:/Documents%20and%20Settings/All%20Users/Application%20Data/inData/TimeCoder%20Pro%205/DepoView/Vendor.dat
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2. This file can be opened with Notepad.  When the Vendor.dat file is opened with 

Notepad, it will look similar to the example below. 

 

3. If necessary, edit information for each vendor information category after the equal ( 

= ) sign.  Save the file when finished.  The updated vendor information will be 

included during the next DepoView Volume export. 

If this information needs to be changed after exporting a DepoView Volume, perform the 

following steps: 

1. Open the Vendor.dat file, which is located in the VENDOR sub-directory of the 

exported DepoView Volume folder. 

2. If necessary, edit information for each vendor information category after the equal ( 

= ) sign.  Save the file when finished.  The updated vendor information will be 

included when the DepoView Volume is burned to CD. 

During the installation of TimeCoder Pro, two default graphics are installed and used 

displayed when launching the DepoView application.  The Vendor.bmp is used for normal 

fonts.  The VendorLF.bmp is used when the target system is running Large Fonts.  The 

default vendor graphic files are for inData Corporation.  

If you would like to use your own company graphic in place of the default, follow the 

instructions below. 

1. Create a bitmap graphic that is 96 DPI and about 352 x 240 pixels in size and save it 

as Vendor.bmp.  

2. Create a bitmap graphic that is 120 DPI and about 440 x 300 pixels in size and save 

it as VendorLF.bmp. 

3. Copy the .bmp file(s) to the \Viewer directory within the TimeCoder Pro application 

data folder. 

By default, this location is - C:\Documents and Settings\All Users\Application 

Data\inData\TimeCoder Pro 6\DepoView\ 

file:///C:/Documents%20and%20Settings/All%20Users/Application%20Data/inData/TimeCoder%20Pro%205/DepoView/Vendor.bmp
file:///C:/Documents%20and%20Settings/All%20Users/Application%20Data/inData/TimeCoder%20Pro%205/DepoView/Vendor.bmp


TimeCoder Pro User Manual 
 

157 

4. Confirm to overwrite the existing image(s). 

From now on, your custom vendor graphic(s) will be used when exporting DepoView 

volumes. 

Burning a DepoView Volume to CD 

Prior to distributing a DepoView Volume to a client, it must be burned to CD/DVD-ROM.  The 

sections below discuss the folder hierarchy of a DepoView Volume and an example of 

burning the contents to CD. 

It is important to understand the item hierarchy of a DepoView Volume prior to burning to 

CD/DVD-ROM.  Proper organization of the DepoView Volume contents on the CD will ensure 

optimal user experience. For example, if the Autorun.exe portion of the DepoView Volume is 

not included on the root of the CD, DepoView will not automatically run (or prompt to 

download) when the user inserts the CD.  

Below is an example of a DepoView Volume that has been exported from TimeCoder Pro: 

 

The Export folder is the output directory, set by the user, when the DepoView Volume was 

exported.  Within the Export folder, the DepoView Volume folder, named MP072195, is 

created. 

As shown below, the DepoView Volume folder contains sub-directories containing exhibit 

files, import files, media files, and vendor files.  The Autorun.inf file is located in the root of 

the DepoView Volume folder. 
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Below is an example of how to properly burn the contents of a DepoView Volume to 

CD.  The example below uses Roxio Creator Classic™ as the burning software.  Please 

reference the documentation for your CD burning software if you need additional 

assistance.  

Important! - Regardless of CD burning software used, it is important to perform the 

instructions in Step #4.  The Volume Label of the CD must match that of the DepoView 

Volume folder (ex. MP072195).  Most CD/DVD burning applications allow the user to modify 

the Volume Label of the CD. 

Disclaimer:  The third-party products discussed in the Help Contents are manufactured by 

vendors independent of inData Corporation.  We make no warranty, implied or otherwise, 

regarding the performance or reliability of these products.  inData cannot assist in 

supporting third-party CD burning applications.  Please contact the manufacturer of your CD 
burning software for assistance. 

1. Select Create a new Data Disc from the File | New Project menu, as shown 

below.  An empty data layout will be created.  

 

2. Next, browse to the output path where the exported DepoView Volume 

resides.  Select the DepoView Volume folder name to display the contents, as shown 

below. 
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3. Select the entire contents of the DepoView Volume and add to the data CD 

project.  The DepoView Volume contents will then be added to the CD Layout, as 

shown below. 

Note:  Make sure that the Autorun.exe, Autorun.inf, .DVT and .VOL files are 

located on the root of the CD layout. 

4. This step is very important to ensure that the Multimedia Resource file is 

automatically found when viewing the deposition with the DepoView or TrialDirector 

applications.  The Volume Label of the CD Layout must be edited to match the name 

of the DepoView Volume folder.  Most CD burning applications use a default Volume 

Label, comprised of the current date and time.  The Volume Label can be edited 

within Roxio Creator Classic™ by simply editing the Disc Name, as shown below. 

 

5. Edit the Disc Name to match the name of the DepoView Volume.  Click Enter to 

apply the change.  The new Volume Label will then appear, as shown below. 
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6. The CD layout is now ready to burn.  Click Burn Disc at the bottom of the Creator 

Classic™ application window to begin.  When the CD has been burned, it can then be 

labeled and distributed. 

Note:  A DepoView Volume does not require any special logo artwork in order to 

distribute.  You may label the CD as you deem appropriate. 

The recipient of a DepoView volume can easily view the synchronized Digital Video 

Transcript, create clips, export clips and search the deposition testimony.  The DepoView 

software is easy to operate for first time users, yet is powerful enough for the seasoned 

professional.  

Upon inserting a CD created from a DepoView volume, the DepoView application is 

automatically launched. (If DepoView has not been installed yet, the user is directed to the 

download page.) 

We recommend that you test DepoView Volumes prior to distribution.  Please reference the 

DepoView online help for additional information about that application. 
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After a DVT has been synchronized by timecoding the transcript, it can be exported to a 

number of various formats for use in other programs. 

Topics: 

 Exporting to a TrialDirector™ Case File (*.cms) 

 Exporting an OpenDVT™ XML File (*.xml) 

 Exporting to a TimeCoder ™ Multimedia List File (*.tml) 

 Exporting Transcript to AMICUS Format (*.ami, *.trn) 

 Exporting Transcript to ASCII Format (*.txt) 

 Exporting to LiveNote / VideoNote Format (*.ptf)(*.vid) 

 Exporting to a MediaPlayer™ Synchronized Media Interchange File (*.smi) 

 Exporting to a SanctionII™ Transcript Database (*.mdb) 

 Exporting to a CT Summation™ Briefcase Format File (*.sbf) 

 Exporting to a Timaro™ Post-Production Timestamp File (*.pts) 

 Exporting to a TrialPro™ Post-Production Timestamp File (*.pts) 
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When a synchronized DVT is exported to a TrialDirector Case File, a Compound Media 

Storage (*.cms) file is created, which can be imported into TrialDirector. 

To export a TrialDirector Case File 

1. Open the DVT you want to export. 

2. Select Export to... | TrialDirector(TM) Case file (*.cms) from the File menu. The 

following window appears: 

 

Note: At any time during the export, you may click Back to return to the previous 

export window or Cancel to cancel the export. 

3. Enter a destination folder and filename for the *.cms, or click Browse to navigate to 

the desired folder and filename. 

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.cms file in the 

File Name field. Click Save to save the selection. 

4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the DVT. When the progress bar reaches the end, 

the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. Click 

OK to exit the export process. 
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The OpenDVT™ XML file is a new open file format for Digital Video Transcripts.  This new 

format was developed by inData, in conjunction with other software vendors, to provide a 

mechanism for the seamless exchange of transcripts and synchronization information 

between applications. 

To export to an OpenDVT XML file 

1. Open the timecoded DVT. 

2. Select Export to... | OpenDVT(TM) XML file (*.xml) from the File menu. 

 

Note: At any time during the export, you may click Back to return to the previous 

export window or Cancel to cancel the export. 

3. Enter a destination folder and filename for the *.xml file, or click Browse to 

navigate to the desired folder and filename. 

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.xml file in the File 

Name field.  Click Save to save the selection. 

4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the OpenDVT XML file.  When the progress bar 

reaches the end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 
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The TimeCoder Multimedia List file (*.tml) is a comma-delimited text file that details 
information about each Multimedia Resource file that is part of the Digital Video 
Transcript. Exporting the TimeCoder Multimedia List file is a handy way to backup 
information about the multimedia files associated with a timecoded transcript. 

The TimeCoder Multimedia List file can be used in place of the audio/video files when 

preserving transcript timecodes during the DVT creation process. 

The TimeCoder Multimedia List file can be used by 3rd party applications (along with a 

timecoded transcript) that need to import data from TimeCoder. 

To export a TimeCoder Multimedia List file 

1. Open the timecoded DVT. 

2. Select Export to... | TimeCoder(TM) Multimedia List (*.tml) from the File 

menu. 

 

Note: At any time during the export, you may click Back to return to the previous 

export window or Cancel to cancel the export. 

3. Enter a destination folder and filename for the *.tml file, or click Browse to navigate 

to the desired folder and filename. 

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.tml file in the 

File Name field. Click Save to save the selection. 

4. When the desired path and filename are selected, click Next. 

 

5. Click Export to begin exporting the TimeCoder Multimedia List file. When the 

progress bar reaches the end, the export is complete. 
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6. Review the export results carefully to ensure that no errors were encountered.  

7. Click OK to exit the export process. 
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Any transcript may be exported to AMICUS (*.ami, *.trn) format. To determine which 

format is best for your purposes, consult the product manual for the application you plan to 

import the transcript into. 

To export to AMICUS format 

1. Open the DVT you want to export. 

2. Select Export to... | AMICUS Transcript (*.ami, *.trn) from the File menu. 

 

Note: At any time during the export, you may click Back to return to the 

previous export window or Cancel to cancel the export. 

3. Enter a destination folder and filename for the exported transcript or click Browse to 

navigate to the desired folder.  

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.ami or *.trn 

file in the File Name field. Click Save to save the selection. 

4. Set the export options, described below. 

Export with Page 

Breaks 
The exported transcript will contain page breaks. 

Export Double 

Spaced 

The exported transcript will be in double-spaced 

format. 

Export with 

Timecodes 

The timecodes that you placed in the transcript will 

be preserved in the exported transcript. This may be 

helpful when archiving your files. 

Include 

Milliseconds 

The timecodes in the exported transcript will include 

milliseconds, in addition to hours, minutes, and 

seconds. This option can only be selected if the 

"Export with Timecodes" option is also selected. 

 

 

5. When the desired folder and filename are selected, and the desired options are set, 

click Next. 

 

6. Click Export to begin exporting the transcript. When the progress bar reaches the 

end, the export will be complete. 
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7. Review the export results to ensure that the operation was completed successfully. 

Click OK to exit the export process. 
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Any transcript may be exported to ASCII (*.txt) format. To determine which format is ideal 

for your purposes, consult the product manual for the application you plan to import the 

transcript into. 

To export to ASCII format 

1. Open the DVT you want to export. 

2. Select Export to... | ASCII Transcript (*.txt) from the File menu. 

 

Note: At any time during the export, you may click Back to return to the 

previous export window or Cancel to cancel the export. 

3. Set the export options as described below. 

Export with Page 

Breaks 
The exported transcript will contain page breaks. 

Export Double 

Spaced 

The exported transcript will be in double-spaced 

format. 

Export with 

Timecodes 

The timecodes that you placed in the transcript will 

be preserved in the exported transcript. This may be 

helpful when archiving your files. 

Include 

Milliseconds 

The timecodes in the exported transcript will include 

milliseconds, in addition to hours, minutes, and 

seconds. This option can only be selected if the 

"Export with Timecodes" option is also selected. 
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4. Enter a destination path and filename for the exported transcript or click Browse to 

navigate to the desired folder.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.txt file in the 

File Name field. Click Save to save the selection.  

5. When the desired folder and filename are selected, click Next. 

6. Click Export to begin exporting the transcript. When the progress bar reaches the 

end, the export will be complete. 

 

7. Review the export results to ensure that the operation was completed successfully. 
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8. Click OK to exit the export process. 
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When a synchronized DVT is exported to the LiveNote / VideoNote format, it can then be 

imported into LiveNote or VideoNote. 

To export LiveNote (*.ptf) and VideoNote (*.vid) files 

1. Open the timecoded DVT. 

2. Select Export to... | LiveNote(TM) / VideoNote(TM) files (*.ptf) (*.vid) from 

the File menu. 

 

Note: At any time during the export, you may click Back to return to the 

previous export window or Cancel to cancel the export. 

3. Enter a destination folder and filename for the *.ptf file, or click Browse to navigate 

to the desired folder and filename.  

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.ptf file in the 

File Name field. Click Save to save the selection. 

4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the DVT to LiveNote / VideoNote files.  When the 

progress bar reaches the end, the export is complete. 
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6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 
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Topics: 

 About SMI Files 

 Export DVT to SMI File 

TimeCoder Pro has a transcript export option that will create .SMI files for use with Windows 

Media Player™. The Synchronized Media Interchange (.SMI) file contains the timecoded 

Digital Video Transcript, specially formatted for use as synchronized captions within 

Windows Media Player™. Using the .SMI file format allows a Windows Media Player user 

(virtually anyone with a PC) to view synchronized transcript text and video. 

When the .SMI file resides next to the source multimedia file (ex. .MPG) within the same 

folder, as shown below, Media Player will be able to use the synchronized transcript text. 

 

Enabling the Captions option within Media Player will allow any corresponding .SMI file to be 

used for text synchronization. The example below demonstrates Media Player displaying a 

text caption from a .SMI file exported from TimeCoder Pro. 

 

Note: Please reference the Windows Media Player help for instructions on enabling the 

"Captions" option. The method for enabling "Captions" depends on the version of Windows 

Media Player. 
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To export a Digital Video Transcript to an .SMI file, 

1. Open the timecoded DVT. 

2. Select Export to... | MediaPlayer Synchronized Accessible Media Interchange 

files from the File menu. 

 

Note: At any time during the export, you may click Back to return to the 

previous export window or Cancel to cancel the export. 

3. Enter a destination folder and filename for the .SMI file, or click Browse to navigate 

to the desired folder and filename. 

a. If you click Browse, the following window appears: 
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b. Select the desired output folder for the .SMI file from the Browse For Folder 

dialog. Click OK to save the selection. 

4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the .SMI file.  When the progress bar reaches the 

end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. Click 

OK to exit the export process. 
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When a synchronized DVT is exported to the Sanction format, it can then be imported into 

Sanction II. 

To export Sanction II (*.mdb) files 

1. Open the timecoded DVT. 

2. Select Export to... | Sanction II(TM) Transcript Database (*.mdb) from the 

File menu. 

 

Note: At any time during the export, you may click Back to return to the 

previous export window or Cancel to cancel the export. 

3. Enter a destination path and filename for the *.mdb file, or click Browse to navigate 

to the desired path and filename.  

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.mdb file in the 

File Name field. Click Save to save the selection.  

4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the DVT to Sanction files. When the progress bar 

reaches the end, the export is complete. 
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6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 
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When a synchronized DVT is exported to the CT Summation Briefcase Format File format, it 

can then be imported into CT Summation Enterprise or iBlaze.   

  

To export CT Summation Briefcase Format (*.sbf) files 

1. Open the timecoded DVT. 

2. Select Export to... | Summation(TM) Briefcase Format File (*.sbf) from the 

File menu. 

 

Note: At any time during the export, you may click Back to return to the 

previous export window or Cancel to cancel the export. 

3. Enter a destination path and filename for the .sbf file, or click Browse to navigate to 

the desired folder and filename. 

  

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the .sbf file in the 

File Name field. Click Save to save the selection.  

4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the DVT to CT Summation files. When the progress 

bar reaches the end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. Click 

OK to exit the export process. 
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TimeCoder Pro can export a Digital Video Transcript to the Timaro™ (*.pts) file format.   

To export to a Post-production Time Stamp (*.pts) file 

1. Open the timecoded DVT. 

2. Select Export to... | Timaro(TM) Post-production Time Stamp file (*.pts) 

 from the File menu. 

 

3. Enter a destination path and filename for the *.pts file, or click Browse to navigate 

to the desired path and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.pts file in the 

File Name field. Click Save to save the selection.  

4. When the desired path and filename are selected, click Next. The following window 

appears: 
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5. Click Export to begin exporting the Post-production Timestamp file. When the 

progress bar reaches the end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 
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TimeCoder Pro can export a Digital Video Transcript to the TrialPro™ (*.pts) file format.   

To export to a Post Production Timestamp (.pts) file 

1. Open the timecoded DVT. 

2. Select Export to... | Trialpro(TM) Post-Production Time Stamp file (*.pts) 

from the File menu. 

 

3. Enter a destination folder and filename for the *.pts file, or click Browse to navigate 

to the desired path and filename. 

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.pts file in the 

File Name field. Click Save to save the selection. 

4. When the desired path and filename are selected, click Next. 
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5. Click Export to begin exporting the Post-production Timestamp file. When the 

progress bar reaches the end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 
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TimeCoder Pro Administrator is a secure, online area where you can add funds to your 

account, monitor jobs in progress, review detailed history for completed jobs, and more.  

To learn how to use TimeCoder Pro Administrator, view the tutorial. The table below is a 

quick reference of common tasks and how to complete them in TimeCoder Pro Administrator 

after you log in. 

  

To do this... Go here... 

Add money to 

your account 

  

Fund Account 

Set it up to 

automatically add 

money to your 

account when 

needed 

  

Fund Account > Setup Autobill 

Change your 

password 

  

My Account > Change Account Password 

View jobs in 

progress 

(occurring on one 

or more 

TimeCoder Pro 

workstations) 

  

Job Console 

View statistics 

(length, accuracy, 

speed, etc.) for a 

completed job 

Account Activity > Description column > click + to expand 

Show/Hide Image 

After you click +, the details appear in the row below: 

 

View, download, 

or print billing 

information for a 

Account Activity > Show Filter Criteria > Select Field > Client ID 

or Case Name > enter the specific client or case > Apply Filter 

     Click Download to save the filtered results to a CSV file. 

http://www.youtube.com/user/inDataCorpTV?blend=4&ob=5
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specific client or 

case 
     Click Print to send the filtered results to your default printer. 

View, download, 

or print 

information about 

completed 

RapidSync jobs 

Account Activity > Show Filter Criteria > next to Type, select 

RapidSync > Apply Filter 

     Click Download to save the filtered results to a CSV file. 

     Click Print to send the filtered results to your default printer. 

View, download, 

or print 

information about 

completed 

AutoSync jobs 

Account Activity > Show Filter Criteria > next to Type, select 

AutoSync > Apply Filter 

     Click Download to save the filtered results to a CSV file. 

     Click Print to send the filtered results to your default printer. 

View, download, 

or print 

information about 

jobs you 

outsourced to 

inData 

Account Activity > Show Filter Criteria > next to Type, select 

OutSource > Apply Filter 

     Click Download to save the filtered results to a CSV file. 

     Click Print to send the filtered results to your default printer. 

See Monitoring Outsourced Jobs in TimeCoder Pro Administrator for more 

information. 

View, download, 

or print 

information about 

DepoView DVD 

charges 

Account Activity > Show Filter Criteria > next to Type, select 

DVDExport > Apply Filter 

     Click Download to save the filtered results to a CSV file. 

     Click Print to send the filtered results to your default printer. 

Add, remove, or 

rearrange 

columns in the 

Account Activity 

grid 

  

Account Activity > Customize Grid 

Create custom 

brochures/mailers 

and access other 

helpful resources 

  

Resources 

View a history of 

IP addresses that 

have logged in to 

TimeCoder Pro 

Administrator, 

date/time, 

duration, etc. 

My Account 
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TimeCoder Pro Administrator is a secure, online area where you can add funds to your 

account, monitor jobs in progress, review detailed history for completed jobs, and 

more.  When you purchase TimeCoder Pro, an Administrator account is established for your 

product serial number. The password you need to log in to TimeCoder Pro Administrator the 

first time is included in the e-mail you should receive after registering TimeCoder Pro. 

To log in to TimeCoder Pro Administrator 

1. On the File menu, click Login to Timecoding Account... 

 

TimeCoder Pro opens your default Internet browser and prompts you to log in to 

TimeCoder Pro Administrator. 

  

2. Your serial number will be populated for you. Enter the password and click Log In to 

continue. 

Notes:  

 You can also find your serial number in TimeCoder Pro under Help > About 

TimeCoder. 

 Passwords are case sensitive. 

 After you log in the first time, you can change your password in the My 

Account area. 
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Your TimeCoder Pro Administrator password is included with your serial number information 

in the email sent to you after you register TimeCoder Pro. After you log in the first time, you 

can change this to a password that you can remember. If at any time you forget your 

password, inData will email it to you at the email address you provided during registration. 

To change your password 

1. After logging in to TimeCoder Pro Administrator, click My Account. 

2. Under Change Account Password, enter your current password, then your new 

password. Confirm the new password and click Save Password. 

To request your password 

1. On the Log In screen for TimeCoder Pro Administrator, click the Forgot your 

password? link. 

2. Enter your serial number and click Send Password to have your password sent to 

the email address you provided when you registered TimeCoder Pro. 

 

You can find your serial number in TimeCoder Pro under Help > About TimeCoder. 
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After you send a job to inData, you can monitor the status from a Web browser on any 

computer using TimeCoder Pro Admininistrator. In the Account Activity area, you can filter 

the grid to show only jobs with a specified Status (i.e. File Arrival, In Production, or Ready 

For Pickup) and select "OutSource" in the Type column. 

 

  

When you view items in the Account Activity grid, look at the Status column. Initially after 

you send the job to inData, the Status column will show "File Arrival": 

 

  

When the job is complete and ready for pickup (download), the Status will show "Ready for 

Pickup": 

 

 

  

After you pickup (download) the DVT, the Status will show "Successful": 
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If you use Adobe  Premiere , you can import your raw DV (.AVI) footage into TimeCoder Pro 

and use it to encode and author your DVD-Video in the same process. This eliminates the 

need to purchase hardware MPEG encoders or to manually encode video to MPEG format 

prior to synchronization. 

  

To encode directly to DVD 

1. Add your raw DV (.AVI) footage using the Multimedia Manager. 

2. Synchronize your transcript with the video. 

3. Follow the steps in Creating a DepoView DVD. 
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When you export a transcript to a DepoView volume, the following files are included: 

 Volume Identification File (*.vol) 

 Autorun Files  (Autorun.exe, Autorun.inf) 

 DepoView Digital Video Transcript (*.dvt) 

 ASCII Transcript (*.txt) 

 AMICUS Transcript (*.ami) 

 TrialDirector Case File (*.cms) 

 TrialDirector Object Load List (*.oll) 

 LiveNote / VideoNote Files (*ptf /*.vid) 

 LiveNote Attached Exhibit List (*.exh) 

 CT Summation Document Information Index (*.dii) 

 CT Summation Briefcase File (*.sbf) 

 TimeCoder Multimedia List File (*.tml) 

 TrialPro / Timaro Post-Production Timestamp File (*.pts) 

 OpenDVT XML File (*.xml) 

 Multimedia Resource File(s) 

 Attached Exhibit File(s) 

 Media Player Synchronized Media Interchange file (*.smi) 

 Vendor Information File 

 Vendor Bitmap 
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When you export a transcript to DepoView DVD, the following load files that can be 

imported into third-party programs are included: 

 .AMI  (AMICUS transcript) 

 .CMS (inData TrialDirector standard load file) 

 .OLL (inData TrialDirector exhibits load file) 

 .MDB (Sanction load file) 

 .SBF (CT Summation transcript and exhibit load file) 

 .DII (CT Summation load file) 

 .PTF/.VID (LiveNote load file) 

 .EXH (LiveNote exhibits load file) 

 .PTS (Timaro Post-Production Timestamp file) 

 .TXT (ASCII transcript) 

 .XML (OpenDVT XML) 

If you are using TrialDirector, you can import the .CMS or .OLL file to view the MPEG-2/VOB 

files from the DepoView DVD. 
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Topics: 

 General Options 

 Deposition Properties 

 Highlight Properties 

 Synchronization Options 

To set the TimeCoder Pro options, select Options from the View menu. The following 

window appears: 

 

Digital Video 
Transcript Data 
Path 

This field allows you to change the DVT data path. 
TimeCoder Pro searches the designated data path for 
available DVT's.  

Click Browse to navigate to a new DVT data path. 

Automatically 
play across 
media breaks 

Enabling this option will allow a Digital Video 
Transcript to continue playback when a media break 
occurs.  If your multimedia resource files reside on 
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removable media (ex. CD) you may want to disable 
this option. 

Single This option single-spaces transcript text. 

1.5 Lines This option spaces transcript text by 1.5 lines. 

Double This option double-spaces transcript text. 

Arrow Keys 
Seek 

This option allows you to designate the number of 
seconds the multimedia file will Rewind or Fast 

Forward each time you seek using the arrow keys. 

Highlight Color This field allows you to change the color of the 
highlight bar. Click Pick to open the color palette and 
choose an existing color, or create your own.  

Text Color This field allows you to change the color of the 
transcript text within the highlight bar. Click Pick to 
open the color palette and choose an existing color, or 
create your own. 

Select the Synchronization tab to view the option related to RapidSync. 

  

Enable 

additional 

audio 

processing 

Enabling this option allows RapidSync to complete the 

highest level of audio processing for the greatest 

accuracy. It increases synchronization time, but can 

significantly reduce the number of questionable (i.e. 

yellow) lines requiring Q/C in your transcript. 
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When you create a DepoView DVD, the MPEG-2 Codec is included on the DVD. When you or 

a client loads the DVD on a computer and installs DepoView software, the codec is 

automatically installed. If you want to install the codec without having to install DepoView 

software, complete the steps below. 

  

To install the MPEG-2 Codec 

1. Load the DepoView DVD on your computer. 

2. Browse the files on the DVD and locate InstallCodec.exe. 

3. Double-click InstallCodec.exe and follow the on-screen instructions. 
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A default data path for file storage is assigned when TimeCoder Pro is installed. You may 

want to set an alternate storage path if, for example, several TimeCoder Pro users share 

data. For instance, if you have a deposition transcript that has 3 separate video parts, a 

team of 3 TimeCoder Pro users can timestamp their own separate video portion of the 

transcript, completing the task in a more efficient manner. 

1. To change the Digital Video Transcript data path, Select Options... from the View 

menu. 

 

2. Next, click Browse to change the DVT data path. The following screen will appear: 
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3. Browse to the new path where you wish to store TimeCoder Digital Video Transcripts 

(DVT) and click OK. The new path will be updated and displayed on the TimeCoder 

Pro Options dialog. 

4. Click OK to save your changes. 

Note: TimeCoder Pro will accept UNC network paths, if you need to store DVT data on 

your network. 
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After a Digital Video Transcript (DVT) has been timecoded and exported to the desired 

formats, you may want to remove it from the list. 

To remove a DVT 

1. To remove a DVT from the list, select Remove Digital Video Transcript(s) from 

the File menu. 

 

2. Select the DVT(s) you would like to remove from the list of available Digital Video 

Transcripts. Use the CTRL key to select multiple DVT's. 

Note: Currently open DVT's cannot be removed and are displayed with a red X 

as shown above. 

3. Click Remove. 

 

4. Click Yes to remove the DVT(s) or No to cancel the removal. 
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UNC is short for Universal Naming Convention or Uniform Naming Convention, a PC format 

for specifying the location of resources on a local-area network (LAN). UNC uses the 

following format: 

\\server-name\shared-resource-pathname 

So, for example, to access the file deposition.txt in the directory Cases on the shared server 

vault, you would write: 

\\vault\Cases\deposition.txt 
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Portions of this program utilize technologies developed at Carnegie Mellon University. (Copyright 1999-2001 

Carnegie Mellon University. All rights reserved.) 

Portions of this program utilize technologies developed by Nexidia, Inc. (Copyright 2005 Nexidia Inc. All rights 

reserved.) 

Contains cryptography software by David Ireland of DI Management Services Pty Ltd.  (www.di-mgt.com.au) 

Windows® is a registered trademark of Microsoft Corporation. 

Access™ is a trademark of Microsoft Corporation. 

Internet Explorer®  is a registered trademark of Microsoft Corporation. 

PowerPoint® is a registered trademark of Microsoft Corporation. 

iBlaze® is a registered trademark of CT Summation. 

Binder® is a registered trademark of RealLegal. 

E-Transcript® is a registered trademark of RealLegal. 

CaseMap® is a registered trademark of CaseSoft. 

TimeMap® is a registered trademark of CaseSoft. 

iConect® is a registered trademark of iConect, LLC. 

Concordance® is a registered trademark of Dataflight Software. 

TrialDirector® is a registered trademark of inData Corporation. 

TimeCoder™ is a trademark of inData Corporation. 

DepoView™ is a trademark of inData Corporation. 

LiveNote® is a registered trademark of LiveNote Technologies, Inc. 

Sanction® is a registered trademark of Verdict Systems, LLC. 

YesEdit® is a registered trademark of YesVideo, Inc. 
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inData Corporation 

225 E Germann Rd., Suite 310 

Gilbert, AZ 85297 USA 

Phone: 480-497-8595 

Toll Free: 877-463-2829 

Fax: 480-497-1833 

Visit inData online: http://www.indatacorp.com 
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